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Preface
This document contains information about the Wavewin file management and Analysis capabilities. The
document also describes the numerous display drivers provided.
This document is intended for use by individuals working in protection, engineering, and system operations.
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System Requirements & Installation
This chapter lists the system requirements needed for installing and running the Wavewin software. It also
describes the installation procedures and provides technical support information.

System Requirements
The system requirements are listed below.






An IBM or compatible PC with an 80486 microprocessor or higher.
500 Megabytes of memory.
2 gigabytes of available hard disk space.
A VGA, 8514/A, or compatible graphics adapter.
Microsoft Windows version XP or higher.

Installation
The system files are distributed in a compressed format. To install the software follow the instruction for the
type of storage media distributed with this manual.
Web: To install the software from the Web access the www.wavewin.net web site. Under the “Wavewin
Upgrades” link click on the Wavewin application to download. Enter your username and password. The
username and password are case sensitive. Click on the software link to download the latest system’s
executable files. Open the zip file and run the install.
USB: To install the software using a USB drive, place the USB drive into the USB port. Navigate to the
installed drive using Windows Explorer and double click on the install.exe program.
Follow the instructions to fully install the software.
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Figure 1.1 Destination Folder
Define the destination folder for the system files then click Next to start the installation.
The destination folder is the location where all files are to be copied. Use the browse button to select an
existing folder.
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Figure 1.2 Finish Install
The install is now complete click Finish to end the installation.

Starting the Software
After you have installed the software on your computer, you are ready to begin. How you begin depends on
your own style. If you like to dive right in and learn by doing the system provides on-line help to assist you.
If you prefer a structured learning approach, read the quick start chapters to get familiar with the software.
To run the software, click on the installed desktop icon or open the Start menu, navigate to the installed
Program folder and click on the Wavewin32 shortcut.

Technical Support
Although this system is easy to use and understand, at some point you may encounter a technical question,
feel that the system has improperly operated, or have suggestions for future improvements. In either case,
contact Softstuf using one of the following methods:
Phone:
Fax:
E-mail:

800-818-3463, 215-922-6880, hours are from 9:00 a.m. to 6:00 p.m. Mon- Fri, (EST).
215-625-2497, response time is 24 hours.
support@softstuf.com, response time 24 hours.
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File Manager Quick Start
This chapter describes the main features of the File Manager.

File Manager Features
The File Manager is used to manage files on disk, search the contents of a drive or directory, and edit, plot,
or draw the contents of a file. This feature is similar to Windows Explorer with application specific functions
tailored for the Power Utility Industry. The functions include automatic event file association, specialized
copy/move engines, intelligent queries, specialized report files, COMTRADE conversion and compression
routines, merge and append waveform and load files, event summaries, and calibration reports.

Figure 2.1 File Manager
When the software is activated, the File Manager displays the subdirectories and files of the last active drive
and directory. This window consists of a folder tree, file table and a query bar. The query bar is located
below the table. The main features are described in the following sections.
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LONG FILE NAMING FORMAT
The File Manager supports the IEEE long file naming format. The IEEE long file naming format is a PSRC
format used to name time sequenced data files. The file table columns are used to display the contents of
the long file name. The file name contains the first ten fields stored in a comma-delimited fashion. The
remaining fields are optional. The file table lists four optional columns at the end of the table to support
user defined fields. The ComNames properties dialog allows for user input for the first two optional fields.
Example: 000112,123433234,-5S,South Arkey,DLP1,Sun Power,T,123.22,+34.6,AG T.OCS
Field Definitions:
Field
Date

Example
000112

Displayed
01/12/2000

Time

123433234

12:34:33.234

Tcode

-5S

-5S

Substation

South Arkey

South Arkey

Device

DLP1

DLP1

Company
File Tag
Line
Length
Fault
Location
Fault Type

Sun Power
T
123.22

Sun Power
T
123.22

+34.60

+34.60

AG T

AG T

Definition
The Date field defines the start date of the file. The
date fields are defined as: the first two characters
are the year, the next two are the month and the
last two are the day. (required)
The time field defines the start time of the file. The
Time fields are defined as: the first two characters
are the hour, the next two are the minutes, the next
two are the seconds and the last two or three are
the milliseconds. (required)
The TCode field is the time offset from GMT time.
If the start time is expressed in UT, this field is
coded 0z,
Note: GMT is the international abbreviation
Greenwich Mean Time. (required)
The substation name or code where the originating
device is located. (required)
The device name or code that generated the file.
(required)
The company of the specifed substation. (required)
The fault type or contents type of the file. (optional)
The line length extracted from the event file. This
field applies to certain relays. (optional)
The fault location extracted from the event file. This
field applies to certain relays. (optional)
The fault type extracted from the event file. This
field applies to certain relays. (optional)

COMNAME(S) RENAME
To rename time sequenced data files using the IEEE long file naming format select the “ComName(s)
Rename” menu option under the “File” menu. ComName(s) Rename will rename all the marked waveform
files to the IEEE PSRC long file naming format. A message box will be prompted before renaming the file
to insure the execution of the rename feature. This feature will permanently rename the files. It is
advisable to back up the files before renaming. Some proprietary applications may not be able to read the
files once they are renamed. For a full description of the format refer to the Long file Naming Format.
For specific display driver’s, information from the file is placed in the long file names.




SEL Files: The user fields has the Event Type and Fault Location (example type field: ",CG T 86.0,").
DLP Files: The user fields has the Fault Type, Distance and Trip Type in the type field (example
type field: ",AG 001.8 PLT,").
st
Transcan Files: The 1 User Field has the 4 character station ID (example user field: ",BEDG,").
14
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st

Rochester Files: The 1 User Field has the 5 character header name (example user field:
",20626,").
Hathaway Files: The #DAU ID data is added next to the device name (example device field: ",DAU
8#8,")

All files associated with the marked files will also be renamed.
 Comtrade files: the ".CFG", ".INF", ".HDR", ".DAT" and "*.D##" files will be renamed.
 Faxtrax files: the ".CTL", ".RCD", ".RCL", ".RCU" and ".RCS" files will be renamed.
 Rochester files: the ".PRE" file and all files with the same name and a ".###" extension will be
renamed.

Figure 2.2 ComNames Rename: Select and Mark all the Waveform Files to Rename

Figure 2.3 ComNames Rename: Result

COMNAME PROPERTIES
The fields defined in the IEEE long file naming format are not always available from the time sequenced
files. The “ComName Properties” dialog allows for setting the most common fields not available in the time
sequenced files. User fields allow for setting specific information into the file name.





Company Name
Time Code
User Field 1
User Field 2

The fields entered are used for all files renamed.
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Figure 2.4 ComName Properties Dialog

COMMAND LINE PARAMETERS
Command line parameters are supported in the Wavewin software. The listed command line parameters
are specific for the file manager and data plotting. Below is a list of all supported command line parameters
and their descriptions:
Command Line
Path and Filename

/Print
/Comtrade

Description
If a path and filename is passed as a command line parameter the
path and filename must be surrounded by quotes, such as
“c:\faultlibrary\event1.dat”. Wavewin will automatically open and
display the file. Only the file is opened in Wavewin. To display the file
manager click on the “File” menu button
.
The “/Print” command line parameter is used along with a path and
filename command line. It automatically opens, displays and prints
the file when Wavewin is executed.
The “/Comtrade” command line parameter is used along with a path
and filename command line. It automatically converts a file to the
IEEE C37.111 Comtrade ASCII 1999 format. The new passed
parameter is /Comtrade. To retain the original file name of the source
file use the /Comtrade passed parameter. To have the file
automatically named using the IEEE C37.232 file naming format use
the /Comtrade=1 passed parameter. The /Comtrade command line
parameter can also be used in batch files. The converted Comtrade
files are saved in the same directory as the source file. The new
passed parameter will convert the source file to Comtrade then
display the converted Comtrade file in the data plotting window.
Below are some examples:
Examples:
------------1.) Passed Parameter: "c:\faultlib\shipdir\SEL-421.CEV" /Comtrade=1
Comtrade Filename: 011207,145119291000,-5,Station A,Relay
1,SOFTSTUF,TRIP,,SOTF B_PHASE C_PHASE GROUND
50,60.00.DAT

/Batch

2.) Passed Parameter: "c:\faultlib\shipdir\DATA1068.RCD" /Comtrade
Comtrade Filename: c:\faultlib\shipdir\DATA1068.DAT
The “/Batch” command line parameter is used along with a path and
16
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/Merge

Fault
SOEList
/X
/Y
/W
/H
/Exit

batch filename command line. It automatically opens the defined
batch file and executes each command line parameter defined in the
file. This feature is used mainly to print or convert to Comtrade a
number of files through one command line parameter.
The “/Merge” command line parameter is used along with a path and
filename command line. It will merge the file with all files that have a
/merge command line parameter associated with them. The /merge
command line parameter is defined in a Merged File.lst ASCII file.
The Merged File.lst is passed to Wavewin through the command line
parameters. All files listed in the Merged File.lst are automatically
merged by time. If the files have different sampling frequencies the
highest frequency is used. The merged file is saved as an ASCII
1999 Comtrade file and placed in the same directory where the
Merge File.lst is located. The Comtrade files are named Merged
File.cfg and Merged File.dat. If an error occurs a Merged File.log file
is created listing all errors encountered.
Example contents of a Merged File.lst:
C:\faultlibrary\event10.dat /merge /exit
C:\faultlibrary\event12.dat /merge /exit
C:\faultlibrary\event14.dat /merge /exit
Automatically display the Fault Data Manager when Wavewin is ran.
Automatically display the SOE List manager when Wavewin is ran.
The “/X” command line parameter tells where to display Wavewin’s
left corner when executed.
The “/Y” command line parameter tells where to display Wavewin’s
upper corner when executed.
The “/W” command line parameter tells the width of the Wavewin
application when executed.
The “/H” command line parameter tells the height of the Wavewin
application when executed.
The “/Exit” command line will automatically exit Wavewin after all
other command line parameters are fully complete.

NAVIGATING
Files:
To browse the files in the active directory use the up, down, right, left, page up, page down, home, end,
ctrl+home, and ctrl+end keys, or use the scroll bars.
Drives/Directories:
To view the contents of a folder, navigate through the folder tree or place the cursor on the folder name
in the file table and press <enter> or double click on the desired folder. The “.” and “..” displayed at the
top of the file table provide shortcuts to the previous folder and the root directory. To return to the
previous folder, place the cursor on the “..” shortcut and press <enter> or click the Up menu button
or press the backspace key. To return to the root folder, place the cursor on the “.” shortcut and press
<enter>.
To change the active drive letter, click the ChDir
menu button or press F7. Enter the drive
letter/path and click OK. To return to the last active folder, enter only the drive letter. To display the
contents of the root folder, enter the drive letter, a colon, and a backslash, for example type “C:\”. An
error message is displayed if the software cannot find or open the specified folder.
To navigate through the last active folders click the Back
menu button or click the right mouse
button to display a list of the connected drives and the last 12 navigated folders..
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Figure 2.5 Folder Tree

Figure 2.6 Drive/Directory Navigation Menu

REFRESH THE ACTIVE DIRECTORY
Click the Refresh
menu button to update the contents of the folder tree and the file table or press F12.
To refresh only the folder tree right click on the folder tree and select the Refresh option. To refresh only
the file table right click on the file table and select the Refresh

menu option.

.
Figure 2.7 Folder Tree Popup Menu
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MARKING FILES
Files are marked and unmarked through the mark menu option, the space bar, or the mouse button. Use
the shift+left mouse button to mark a group of files or the ctrl+left mouse button to randomly mark files.
Marked files are displayed in red and can be copied (F8), moved (F9), deleted (Delete), grouped, sorted or
plotted.

SORTING FILES
The column headers displayed at the top of the table are used to sort all the files in the table. Click the
header buttons to toggle between ascending and descending order
or use the Sort menu
option to sort all or marked files with respect to the selected sort field. To change the sort field, place the
cursor in the desired column and select “Set Sort Field” from the Sort menu. The active sort field is
displayed in the status bar at the bottom of the window

.

COPYING OR MOVING FILES
Files must be marked in order to copy or move them from the active folder. To copy/move files using the
Window’s Folder Tree dialog click the Copy To
/ Move To
menu buttons or press F8 for copy
and F9 for move. Select the folder from the Directories tree or click on the New Folder button and enter
the new directory name then press <enter>. A message is displayed if an error occurs while copying or
moving the files. The Cancel button or the <esc> key terminates the command.
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Figure 2.8 Copy Dialog
To copy or move files to the clipboard select the Copy/Cut menu options under the Edit menu or right click
in the file table and select the Copy

or Cut

option from the popup menu. Navigate to the

destination folder and select the Paste option under the edit menu or the Paste
file table’s popup menu.

option from the

To move files using the drag and drop feature, first mark the files in the file table then drag them to the
desired folder in the Folder tree. Once the move is complete, a message box will be displayed listing the
number of files moved to the selected folder.
After a copy/move or paste command is executed and a file is successfully transferred to the destination
directory, the system's task bar in the upper right hand corner of the screen is updated. All files that were
unsuccessfully copied/moved using the Copy/Move menu buttons are marked and grouped at the top of
the table.
The specialized copy/move/paste engine copies the COMTRADE and DFR header and configuration
information along with the selected data file. For example, when a data file is copied or moved the
corresponding header information (CFG, HDR, INF, DAU-DEF, SCF File, CTL File and *.PRE files…) are
automatically copied from the source folder to the destination folder.
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EMAIL FILES
Files must be marked first (displayed in red) to email. Mark all of the files to email then click the Email
menu button
or right click in the file table to display the popup menu and select the Email
option. The users default email program is displayed with all marked files in the attachment section. Also,
any support files needed to display the selected files will be automatically attached. Support files include
Comtrade .CFG, .HDR and .INF files, Hathaway DAU files, Transcan .SCF and .TCF Files, Faxtrax or
Director .CTL files and Rochester .PRE, Machine.DAT and Data files.

Figure 2.9 Email Dialog

ZIP FILES
To zip a group of files first mark the files. Marked files are displayed in red. To zip the marked files click
the Zip Marked Files menu option under the File menu or right click in the file table to display the popup
menu and select the Zip
option. The zip dialog is displayed. Enter the filename and folder. Click the
Folder
button to browse and select a destination folder. If no destination folder is defined, the zip file
is saved to the file table’s active folder. Also, any support files needed to display the selected files will be
automatically included in the zip file. Support files include Comtrade .CFG, .HDR and .INF files. The zip
files created are compatible with the WinZip and PKZip applications.
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Figure 2.10 Zip Dialog

CUSTOMIZING THE TABLE DISPLAY
The columns displayed in the table can be repositioned through the “Display” menu option in the “Options”
menu. Use the Move Up and Move Down buttons to change the position of a column. The table columns
can also be resized. Position the mouse over the column separator and drag the mouse to the desired
location or double click on the table separator to resize the column to the largest display.
The size of the font displayed in the table can also be changed. Use the “Table Font Size” drop down list
to select the desired font. Also, to use the Window’s default file marking, select the “Windows” option from
the “File Marking” drop down list. To mark files with a single mouse click select the “Single Mouse Click”
option.
The default path that is displayed when the file manager is first opened is defined in the “Default Path”
field. Enter the path or use the Browse button to select the path.
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Figure 2.11 Customize Table Columns

PRINTING THE FILE TABLE
The print feature provides two options: print all or marked files in the active directory. To print all the files
select the print all rows menu option under the file menu. To print the marked files select the print marked
rows menu option under the file menu. An error message is displayed if the software cannot access the
printer port.

COMPRESSING COMTRADE ASCII FILES
The File Manager contains a built in compression routine that converts COMTRADE ASCII files to
COMTRADE Binary files. To compress COMTRADE ASCII files, mark the files and select “Compress
COMTRADE Files” from the Options menu. The software prompts for confirmation, click Yes to continue,
or No to cancel.

SAVING AS COMTRADE
Oscillography formats supported by the software can be converted to the COMTRADE ASCII or Binary
format. Three Comtrade versions are supported: the older 1991 format, the 1999 format and the newest
2013 format. The new 2013 Comtrade format can be saved as a single file with the CFG, HDR and DAT all
contained in the single file. The new Comtrade single file format has a CFF extension.
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The Comtrade format is selected from the Data Plotting Window’s Properties dialog. The default format is
the 1999 format. To create a COMTRADE file place the cursor on the event file or mark the desired files
and select “Save As COMTRADE” (ASCII or Binary) from the Options menu. Enter the destination path
and filename (do not enter a filename extension) and click OK. The “.DAT” and “.CFG” files are
automatically created. If a path is not defined, the COMTRADE files are saved in the active directory.
If the sample values in the selected file(s) are RMS calibrated and the desired Comtrade file must have
instantaneous values set the “Comtrade Settings” fields to automatically convert the RMS data to
instantaneous values. To set the “Comtrade Settings” fields open the “Window Properties” dialog in the
analysis display. Select the “Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to
Peak Data”.

Figure 2.12 Comtrade Version
To automatically convert the selected file(s) to Comtrade using the IEEE long file naming format check the
“Use the ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As Comtrade”
Dialog and leave the File Name field empty. All files marked in the table will be converted to the selected
Comtrade format and will be named using the IEEE long file naming convention.
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Figure 2.13 Save As Comtrade

RUNNING APPLICATIONS
Files that contain the extension EXE, BAT, and COM can be activated from the file table. To run an
application from the active folder place the cursor on the filename and press <enter> or double click the
mouse button. To run an application from a non-active folder select “Run” from the File menu, enter the
path and the filename in the “Open” field, and click OK.

Figure 2.14 Run Dialog

DISPLAYING OSCILLOGRAPHY RECORDS
A library of device drivers is used to display various types of oscillography formats. The drivers below are
available in the Wavewin Universal Viewer and Full version. The Comtrade driver is available in all
versions. The formats supported by the system are:
COMTRADE ASCII and Binary
Hathaway DFR I, II, IIB, and 2000
Emax Faxtrax & Director DFR
Mehta Transcan DFR
Rochester TR16** DFR
SEL Relays (all series including the compressed format)
ABB Relays (REL 301/302, MDAR 300, GPU, TPU & DPU 2000R and below)
ABB Load Profile (Wye-Connected VTs and Delta-Connected VTs)
GE Relays (DLP1 & DLP3)
Dranetz SER
Satec PM295
RFL 9300
SDC Log Files
Fluke Scope Meter
SEL Load Profile Data
SEL Sag/Swell/Interruption Files (SSI)
Ametek TR-100+, DL-8000, TR-2000 & P&QR128
ERLPhase Tesla
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ERLPhase BPRO, TPRO, LPRO & FPRO
Emax Long Term Records
GE-SRSeries
Hathaway Replay Plus (DFR, TSS & CSS files)
TIS
S&C IntelliRupter Waveform
S&C PXI
S&C Extended Waveform Capture
Audio Wave File
S&C Meter
S&C Daily High Low File
Nicolet PNRF
Nicolet Power Pro WFT
Comma Delimited (Time, Channel) format
SDC Comma Delimited Files
Audio Wave Files
To plot the contents of a file, place the cursor on the filename and select the appropriate driver from the
“Driver” menu. A maximum of ten display windows can be opened at one time. Refer to the “Analysis”
section for more information.

ASSOCIATING FILE TYPES
The File Manager automatically associates file types according to the file naming structure. The associated
driver is displayed in the driver column. When the <enter> key is pressed or the default mouse button is
double clicked the software inspects the filename at the cursor and executes the assigned driver. Files are
associated according to the following parameters:
Driver
Directories
Applications
Hathaway DFR I,II,
IIB & 2000
EMAX Faxtrax II /
Director
Mehta Transcan
Rochester TR16**
NxtPhase Tesla
COMTRADE
SEL
SEL LPD
DLP

Association Parameter
Directories are tagged according to the parameters read from the file allocation
table.
Files with the extension “.BAT”, “.COM”, or “.EXE” are tagged as application
files.
Files that match the Hathaway Base32 file naming scheme or are long files
with the .DFR extension are tagged as DFR I,II, IIB, & 2000 files.
Filenames with the extensions “.RCD”, “.RCL”, “.RCU”, and there is a
cooresponding “.CTL” file, are tagged as Faxtrax II / Director files. The Emax
Faxtrax II / Director (12-bit/16bit) format is supported.
Files that have an extension starting with “X” and a corresponding “.SCF” file
exists are tagged as Mehta Transcan files.
Files that have the same name and an extension with a number and there is a
corresponding .PRE file in the same directory are tagged as Rochester files.
Files with the extension “.TLR” are tagged as NxtPhase Tesla files.
Files with the extension “.DAT” that have a cooresponding “.CFG” file are
tagged as COMTRADE files.
Files with the extensions “.SEL”, “.CEV” or “.EVE” are tagged as SEL files.

REL300/301/302

Files with the extension “.BSV” are marked as SEL Load Profile Data files
Files with the extension “.OSC” are tagged as DLP relays. GE DLP1 and DLP3
formats are supported.
Files with the extension “.REL” are tagged as ABB-MDAR files.

TPU/DPU/GPU
ABB Load Profile
GE SR745/489 File

Files with the extension “.CAP” are tagged as ABB-TPU/DPU/GPU files.
Files with the “.DLA” extension are tagged as ABB Load Profile-Wye files.
Files with the “.CSV” extension are tagged as GE SR745 Files.
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Driver
SDC Log File
TIS File
Ametek Files
NxtPhase Relays
(BPRO, TPRO,
LPRO & FPRO)
Emax Long Term
Hathaway Replay
Plus
S&C IntelliRupter
Nicolet Power Pro
WFT
Nicolet PNRF
S&C PXI
S&C Extended
Waveform Capture
Audio Wave
S&C Meter
DXF
Application Files

ASCII

Association Parameter
Files with the “.CSV” extension are tagged as SDC Log Files.
Files with the “.TIS” extension are tagged as TIS (Trip Information System)
Files.
Files with the “.AMT” extension are tagged as Ametek TR-100+, DL-8000, TR2000 & P&QR128 Files.
Files with the “.BPR, .TPR, .LPR, FPR” extensions are tagged as NxtPhase
Relay Files.
Files with the “.DAT” extension with an associated “.SET” file are tagged as
Emax Long Term Files.
Files with the “.DAT” extension with no “.CFG” associated with it are tagged as
Hathaway Replay Plus Files.
Files with the extension “.WFC” are tagged as S&C IntelliRupter Waveform
Files.
Files with the extension “.WFT” are tagged as Nicolet Power Pro WFT Files.
Files with the extension “.PNRF” are tagged as Nicolet PNRF Files.
Files with the extension “.TSV” are tagged as S&C PXI Waveform Files.
Files with the extension “.EWC” are tagged as S&C IntelliRupter Extended
Waveform Files.
Files with the extension “.WAV” are tagged as Microsoft’s Wave Files.
Files with the extension “.PRO” are tagged as S&C IntelliRupter Meter Files.
Files with the extension “.DXF” are tagged as Drawing Exchange Format files.
Word Documents (“.Doc” & “.RTF”) , Execl Documents (“.XL”, ”.XLS”, “.XLT”,
“.XLM”, “.XLA”, “.XLC” & “.XLW”) , Web pages (“.HTM”, “.HTML”, “MSPX” &
“ASP”) , Access Files ('”MDB” & “.ADP”) , Power Point Presenation files
(“.PPT” & “.PPS”) , Image files (“.GIF”, “.TIF”, “.JPG”, “.JPE”, “.BMP”, “.PSD” &
“.PDD”) , Zip files (“.ZIP”) , and PDF files (“.PDF”) are automatically associated
with their source application.
All other files are tagged as ASCII files.

To change the driver type, place the cursor on the filename and select the driver from the Drivers menu.
Once a driver is assigned the file contents appear in the corresponding display window. If the driver
encounters an error while reading a file an “Invalid Driver Message” is displayed indicating the line number
in which the error was encountered. Use the ASCII or Hexadecimal editors to locate and correct the error.
The ASCII and hexadecimal editors display the cursor’s line and character number in the lower left corner
of the window.
The “Auto Detect” feature inspects the file at the cursor position and tags it according to the filename.

DEVICE CONFIGURATION
The device configuration dialog allows for setting certain parameters for each type of device driver
supported. To open, select the “Device Configuration” menu option under the “Options” menu. The right
panel displays all the supported device drivers. Use the mouse or up and down arrow keys to select the
device. The left panel displays the available settings for each device. Below is a list of the available
settings:



Device’s Data Type: Options (Peak, RMS Calibrated or Log File). Select the type of data that is
contained in the files for the selected device.
Device Header Directory: If the device requires support files to display the data then the support
files can be placed in a centralized directory so they do not have to be in the directories where the
data files are located. Enter the directory or use the folder button
to browse for an existing
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directory. This field is for devices that maintain separate files for the Analog & Digital information.
This field is available for Hathaway, Transcan, Rochester and Comtrade Files.
Change Sampling Frequency: This field is used to automatically change the sampling frequency
when a file is displayed for this driver. For example, if the files have 4 samples per cycle and it is
preferred to view the file with 40 samples per cycles enter 2400. To maintain the original frequency
leave this field blank or set to 0.00.
Change Line Frequency: If the line frequency is not defined in a specific driver’s files then the
line frequency can be defined in this dialog. The entered line frequency will be used when
displaying files for the selected driver. To maintain the original line frequency, leave this field blank
or enter 0.00.

Figure 2.15 Device Configuration Dialog
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DAU-DEF EDITOR
The DAU-DEF editor allows for changing the setting for all the available devices defined in the selected
Hathaway DAU-DEF file and for adding new dau def configurations. To open, select the “Edit DAU-DEF
File” menu option under the “Options” menu. Navigate to the desired directory and double click on the
dau-def file. The right panel displays all the devices defined in the file. Use the mouse or up and down
arrow keys to select the device. The left panel displays the available settings for each device. Below is a
list of the available settings:








Station Name: Enter or change the station name.
Telephone #: Enter the telephone number to connect to the device.
Analog Channels: The analog channels defined for the selected DAU-DEF record are displayed
in a list box. Use the up and down arrow keys or the mouse to select the analog channel to
modified. The following fields can be modifed for each analog channel.
o Name: Modifiy the analog channel name.
o Full Scale: Modify the analog channel’s full scale value.
o Prefix: Modify the analog channel’s prefix.
o Unit: Modify the analog channel’s unit.
Event Channels: The event channels defined for the selected DAU-DEF record are displayed in
a list box. Use the up and down arrow keys or the mouse to select the event channel to modified.
The following fields can be modifed for each event channel.
o Event #: Modifiy the event channel’s number.
o Name: Modify the event channel’s name.
o NoNc: Modify the event channel’s normally open or normally closed value, option (1,0).
Sensor Channels: The sensor channels defined for the selected DAU-DEF record are displayed
in a list box. Use the up and down arrow keys or the mouse to select the sensor channel to
modified. The following fields can be modifed for each sensor channel.
o Sensor #: Modifiy the sensor channel’s number.
o Name: Modify the sensor channel’s name.
o NoNc: Modify the sensor channel’s normally open or normally closed value, option (1,0).

To add a new DAU-DEF configuration click on anyone of the “NOT USED” records and fill in the analog
and digital information and click “Save”. The DAU-KEY and DAU-TYPE files are updated automatically.
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Figure 2.16 Hathaway DAU-DEF Editor

ERLPHASE FILES
ERLPhase Tesla and Relay Files are displayed in the IEEE Comtrade Binary format. ERLPhase has
developed an automatic conversion DLL called RecordExAuto.dll and TeslaConfigFile.dll to convert their
proprietary files to the Comtrade format for display. To view ERLPhase Files double click or press enter on
the orginal Tesla files.
To edit the Tesla AutoComtade configuration, open the “Device Configuration” dialog from the “Options”
menu. Select the NxtPhase-Tesla device under the device list box. Below is a list of the available settings:




Use Long Name Convention: The converted tesla files can automatically be named using the
IEEE PSRC Long File Naming Convention. Select “Yes” to have them automatically renamed. If
“No” is selected then the files are named using the original file name with the sampling frequency
truncated to the name. Example: the “2002-07-23-15.49.01.000F1.tlr” Tesla file’s Comtrade files
will be named: 2002-07-23-15.49.01.000F1-Converted_S96.dat.
Delete Original’s: To delete or send the original Tesla file to the recycle bin select “Yes”. All files
that can be recycled will be sent to the Window’s recycle bin all other are permentally deleted from
the active drive. To maintain the original files select “No”.
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Figure 2.17 Tesla Configuration

LOAD ANALYSIS
The Load Analysis routines are a set of rules and methods used to measure 3 types of abnormal circuit
conditions: imbalance, overload and inefficiency in a load “*.CSV“ file. When the load file is processed 4
analog channels and 5 digital channels are created in the file:
Analog Channels:
 Max Rating – The max rating channels displays the defined maximum rating.
 I Average – The I Average channel displays the average value from the IA, IB and IC channels.
 I Max – The I max channel displays the maximum value from the IA, IB and IC channels.
 Derivative – The derivative of the power factor channel.
Digital Channels:
 Breaker Status – The breaker status channel is marked as triggered when a sample indicates an
OPEN in the breaker status field (BRK).
 Data Integrity – The data integrity channel is marked as triggered when the date and time for a
sample is invalid and the difference between the current samples and the previous samples are
greater than 5 times the defined rating.
 Imbalance – The imbalance channel is marked as triggered when an imbalance condition is
detected. Refer to the Imbalance section below for more detail.
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Overload – The overload channel is marked as triggered when an overload condition is detected.
Refer to the Overload section below for more detail.
Inefficiency – The inefficiency channel is marked as triggered when an imbalance condition is
detected. Refer to the Inefficiency section below for more detail.

Before the load analysis routines can be performed on a file the ratings for the device must be defined. To
define the ratings select a file in the file manager then select the “Load Rating” menu option from the
“Reports” submenu option under the “Options” menu. Enter the “Summer Normal Rating” and the
“Summer Emergency Rating”.

Figure 2.18 Load Rating Dialog
An adaptive learning scheme is used to tune the time varying coefficients (W1, W2 & W3) of an imbalance,
overload and inefficiency summation equation. The equation is used to classify circuit conditions (i.e.,
assign priority values).
Figures 4.19 and 4.20 reveal the basic schematic of the expert and adaptive learning models used. Terms
used in Expert System Model are defined as follows:












IA
IB
IC
AVG
SNR
PF
X-I
X-O
X-E
IMB
OVR

Phase-A current (Amps RMS)
Phase-B current (Amps RMS)
Phase-C current (Amps RMS)
Average of Phases A, B, and C
Summer Normal Rating for the circuit (Amps RMS)
Power factor
Maximum imbalance value (max % change from average)
Maximum overload value (max % change from rating)
Maximum inefficiency value (max % change from unity)
Discrete imbalance signal (1=On, 0=Off)
Discrete overload signal (1=On, 0=Off)
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INE
T-I
T-O
T-E

Discrete inefficiency signal (1=On, 0=Off)
Total imbalance duration (Days, Hours)
Total overload duration (Days, Hours)
Total inefficiency duration (Days, Hours)

Figure 2.19 Expert System Model
Terms used in Adaptive Learning Model are defined as follows:









X
W-1
W-2
W-3
+
Desired
Err Function

Multiplication node
Time varying coefficient for imbalance condition
Time varying coefficient for overload condition
Time varying coefficient for inefficiency condition
Summation node (good/bad circuit classification branch)
Subtraction node (error signal generation branch)
Input signal used to train the network
Cost function that governs the assignment of coefficient values

Figure 2.20 Adaptive Learning Model
The “Load Trigger” Dialog allows for programming the level, weight, and duration triggers for the analysis
procedures. The triggers are listed by circuit type.
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Figure 2.21 Load Analysis Triggers Dialog
A description of the analysis procedures follows:
Imbalance: The system calculates the average value of the 3 phase currents and then measures the
difference between each phase and the average. If the maximum percentage change from average is
greater than the “Over Trigger” value (say 10% of average) then an imbalanced condition is noted and the
maximum percentage imbalance and total duration are tracked. If the condition persists for a consecutive
number of readings that is greater than the “Duration” value (say 6 hours) then an actual imbalance alarm
is issued.
Overload: The system measures the maximum value of the 3 phase currents and then compares to the
summer normal rating that is provided for that circuit. If the maximum value is greater than the “Over
Trigger” value (say 90% of rating) then an overload condition is noted and the maximum percentage
overload and total duration are tracked. If the condition persists for a consecutive number of readings that
is greater than the “Duration” value (say 4 hours) then an actual overload alarm is issued.
Inefficiency: The system looks at the power factor measurements and directly compares to the “Under
Trigger” value (say 90% of unity). If the value is less than “Under Trigger” then an inefficiency condition is
noted and the maximum percentage inefficiency and total duration are tracked. If the condition persists for
a consecutive number of readings that is greater than the “Duration” value (say 5 hours) then an actual
inefficiency alarm is issued.
Cumulative Values: The system calculates a weighted sum of the tracked maximum percentages for
imbalance, overload and inefficiency and uses that sum as a priority measure to rate the condition of each
circuit. The weights are specified in the “Weight” field as “multiplier, extreme duration”. The actual weight
is equal to the multiplier value but it doubles when the total duration exceeds the specified extreme
duration.
Data Filters: Data measurements that are taken outside the interval “Start Time” to “End Time”, or that
have values below “Ignore Under”, are not processed and the previous state of the system is retained.
The system also detects “bad data” (due to spikes, network crashes, incorrect unit designations, modem
communication failures and so on) and blocks it from propagating through the system.
To perform the analysis on a directory containing *.CSV load files first mark the desired files then click on
the Load Analysis menu button to display the Load Analysis Triggers dialog or select the desired load
option from the load analysis drop down menu.
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Figure 2.22 Load Menu Button
The first three menu options are also available from the Load Analysis Trigger dialog. Below is a
description for each option available.





Process & Update Database – The process & update database will process all the marked *.CSV
files in the active directory and update the Max-Imbalance, Max-Overload, Max-Inefficiency and
the Priority columns with the new data.
Process & Create Summaries – The process & create summaries will process all the marked
*.CSV files in the active directory and create device summary ASCII files for each file processed.
A folder destination dialog is displayed. Refer to Figure 2.23. Select the destination folder and
define the names for the files. The files are named using the IEEE PSRC Long file naming
convention when the “Use ComName” option is checked.
Process & Save As Comtrade – The process & create summaries will process all the marked
*.CSV files in the active directory and create Comtrade files for each file processed. A folder
destination dialog is displayed. Select the destination folder and define the names for the files.
The files are named using the IEEE PSRC Long file naming convention when the “Use
ComName” option is checked.

Figure 2.23 Summary Destination Dialog
Summary Files:




Device Summary – The device summary files list all the general information for the file, the
maximum and minimum values for imbalance, overload & inefficiency, the maximum and minimum
values for each analog channel and SOE for the digital channels.
Station Summary – The station summary lists the imbalance, overload, inefficiency and priority
for each device in the station.
System Summary – The system summary lists the imbalance, overload, inefficiency and priority
for each device defined in the system along with the average for each station.
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Figure 2.24 Load Device Summary

Figure 2.25 Load Station Summary
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Figure 2.26 Load System Summary

VIEWING/MODIFYING ASCII FILES
The ASCII Editor allows for viewing and/or modifying the contents of a text file. To open an ASCII file place
the cursor on the filename and press F2, or click the Edit menu button
. Use the up, down, right, left,
ctrl+right, ctrl+left, page up, page down, home, end, ctrl+home, and ctrl+end keys, the scroll bars or the
search (F4) and search again (F3)
features to navigate through the file contents. The line and
character number at the cursor position are displayed in the status bar (bottom left corner of the window).
The Cut (ctrl+x)
, Copy (ctrl+c)
, and Paste (ctrl+v)
commands are also provided. New files
can be created or existing files can be opened, saved and saved under a new name. A maximum of ten
editing windows can be opened at one time.
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Figure 2.27 ASCII Editor

VIEWING/MODIFYING BINARY FILES
The Hexadecimal Editor allows for viewing and/or modifying the contents of a binary file. To open a binary
file, place the cursor on the file and press F3. The Hexadecimal window consists of a hex editor and an
ASCII display. When a hex value is entered, the ASCII equivalent appears in the window to the right of the
editor. To navigate through the file contents use the up, down, right, left, page up, page down, ctrl+home,
and ctrl+end keys or the scroll bar. The byte number at the cursor position is displayed in the lower left
corner of the window. To search the contents of a hex file use the search (F4) and search again (F3)
functions. To search the ASCII window enter the ASCII information into the “Find Text” Field. To search for
a hex value, enter “#”, then the hex number into the “Find Text” field.
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Figure 2.28 Hexadecimal Editor

Figure 2.29 Hexadecimal Search

VIEWING WAVEFORM SUMMARIES
The File Manager and Analysis Display generate an analog and digital summary for the supported
oscillography formats. The summary engine extracts key information from the file and saves it to a small
summary file. The header, analog, and digital information includes:
Event Information
Field
Station
Filename
File Size
Prefault-Time
Fault-Time
Save-Time
Process-Time
Start Date and
Time
End Date and

Description
Name of the Station associated with the event file.
Name of the event file.
File size (displayed in kilobytes).
Date and time of the first prefault sample.
Date and time of the first fault sample.
Date and time the file was saved to disk.
Date and time the file summary was processed.
Date and time of the first sample in the file.
Date and time of the last sample in the file.
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Field
Time
File Duration
Sampling
Frequency
Line Frequency

Description
Duration of the file measured in days, hours, seconds, milliseconds and/or
microseconds, depending on the type of file.
Sampling frequency and the time between each sample.
Line Frequency defined in the file.

Fault Information - Fault Information is displayed for files that include fault information in their format.
Driver
Fault Information
SEL
Event, Location, Frequency, Duration, Shot, Fault Currents, Targets and more.
DLP
Trip Date and Time, Trip Type, Fault Type, Distance and Operating Time.
Transcan
Triggered event information: Name, Time and Type.
Maximum/Minimum Analog Summary
Field
Description
Max-Inst
Instantaneous maximum values.
Min-Inst
Instantaneous minimum values.
Max-RMS
RMS maximum values.
Min-RMS
RMS minimum values.
OneBit
Channel's full-scale value divide by the channel's resolution.
Inst-Diff
The difference between the Max-Inst and Min-Inst values.
RMS-Diff
The difference between the Max-RMS and Min-RMs values.
pU
Channel prefix and unit.
Description
Channel title and number.
Events/Sensors Activity Summary
Field
Description
Fst
State at which the channel started, A=alarm and N=normal.
Lst
State at which the channel ended, A=alarm and N=normal.
Fst-Change
Date and time the channel first changed state.
Lst-Change
Date and time the channel last changed state.
Changes
Number of times the channel changed state.
Description
Channel title and number.
Events/Sensors Activity Log
Field
Description
State
State of the channel at the triggered time, A=alarm and N=normal.
Trigger Time
Time the channel-changed state.
Description
Channel title and number.
The xx:xx:xx.xxx displayed in the “Fst-Change” and/or “Lst-Change” fields of the Events/Sensors Activity
Summary indicates that the digital channel’s state did not change from the initial state (Fst).
To generate a summary file, place the cursor on the filename and click the Summary
select “Waveform Summary” from the “Options” menu.

menu button or
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Figure 2.30 Waveform Summary

WAVEFORM FILE(S) OPTIONS
OPEN SELECTED FILE
The Open Selected File option opens the waveform file at the cursor position. Refer to the Displaying
Oscillography Records section for a list of the supported waveform files.

OPEN ALL MARKED FILES
The Open All Marked Files option opens all the marked waveform files, tiles the waveform files
horizontally and minimizes the file manage. To access the file manager click the “Files” menu button
.
A maximum of ten data windows can be opened at one time.
The plot button icon
plotted.

will plot all the marked files. If there are no marked files, the selected file is

APPEND WAVEFORM FILES
The Append Waveform Files option appends the marked files according to time. There are two options
available under the Append Menu:
 Discard Common Times: Any common times found in the marked files will be deleted from the
older file.
 Back to Back: The files are appended back to back. No samples are deleted.
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Figure 2.31 Append Waveform Files: Discard Common Times

Figure 2.32 Append Waveform Files: Back to Back
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MERGE WAVEFORM FILES
The Merge Waveform Files option merges the marked waveform files. There are two options available
under the Merge Menu:
 By Time: Merge channel samples if they have a common time segment. The reference time is
derived from the file with the latest start date and time. The file with the least amount of
samples determines the length of the new merged file.
 By Sample: Merge regardless of time stamps. The reference time is derived from the first
marked file. The file with the least number of samples determines the length of the file.
When files with different sampling frequencies are merged a dialog will be displayed. The dialog
contains a list of all the sampling frequencies in the marked files. Select the frequency for the merged
file or enter a new frequency.

Figure 2.33 Merge Waveform Files: Select Frequency
If the merged files have different data types (RMS Calibrated or Peak Values) then the RMS values will
be converted to Peak values by multiplying the RMS values by Root 2.
To identify the merged channels the station name for each file is added to the beginning of the analog
and digital channel names. To turn off this feature open the Properties dialog
in the analysis
window. Click on the Append/Merge tab and uncheck the “Add the File’s Station Name to Beginning of
the Analog/Digital Channels” field.
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Figure 2.34 Append/Merge Properties
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Figure 2.35 Merge Waveform Files By Time

Figure 2.36 Merge Waveform Files By Sample
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FILE REPORTS
GENERATING CALIBRATION REPORTS
The Calibration report list the Maximum and Minimum analog summary information for the marked files.
Calibration reports should only be generated on files that contain no fault data such as snap shot files.
To generate a report, mark the desired files and select the “Calibration…” menu option from the
“Report” submenu option under the “Options” menu. Refer to the “Summary” section for field
descriptors. The report information is saved in the DVREPORT.DTB file located in the Wavewin
directory.

GENERATING SEQUENCE OF EVENTS (SOE) REPORTS
To generate a table of sequence of events from multiple waveform files, mark all of the desired files
then press F11 or Select the "SOE List" menu option from the "Reports" submenu under the "Options"
menu. A table listing all of the events triggered in the selected files is displayed. The table is sorted
according to date and time. The columns listed in the table include:
State: The state on the event/sensor at the displayed date and time (A=Abnormal, N=Normal).
Trigger Date: The date the event/sensor triggered or cleared.
Trigger Time: The time the event/sensor triggered or cleared.
Chan: The channel number of the event/sensors in the file from which it was read.
Channel Title: The channel title of the event/sensors.
Device: The device from which the event/sensors originated.
Substation: The substation from which the event/sensors originated.
File: The filename from which the event/sensors originated.
The Query section at the bottom of the table allows for searching events from specific substations,
devices, and channels. To plot the specific events press <enter> or double click on the event.

Figure 2.37 SOE List
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GENERATING SEQUENCE OF EVENTS (SOE) SUMMARIES
To generate a summary of the sequence of events for multiple waveform files, mark all the desired files
then Select the "SOE Summary" menu option from the "Reports" submenu under the "Options" menu.
A table listing a summary of all the events triggered in the selected files is displayed. The table is
sorted according to date and time. The columns listed in the table include:
Substation: The substation that triggered the event/sensor.
Device: The device that triggered the event/sensor.
Fst-State: State the channel started at, A=alarm and N=normal.
Lst-State: State the channel ended at, A=alarm and N=normal.
Fst-Change Date: Date the channel first changed state.
Fst-Change Time: Time the channel first changed state.
Lst-Change Date: Date the channel last changed state.
Lst-Change Time: Time the channel last changed state.
Changes: Number of times the channel changed state.
Chan #: Channel number in the file.
Channel Title: The channel title of the event/sensor.
File: The filename from which the event/sensors originated.
The Query section at the bottom of the table allows for searching events from specific substations,
devices, and channels. To plot the specific events press <enter> or double click on the event.

Figure 2.38 SOE Summary

APPENDING LOG FILES
The Appending Log features combine an unlimited number of CSV log files into one file. The files must
be marked and of the same type (generated from the same device). The generated combined file can
be displayed in a table or plotted in the log data viewer. This feature allows for analyzing load data over
a long period.
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COMBINDING LOG FILES
The Combine Log feature combines an unlimited number of CSV log files into one file. The files must
be marked and can be from different file types (generated from different devices). The substation and
device of each file is added in the file. The saved file is displayed in a table. This feature allows for
analyzing load data over a long period for different devices.

VIEWING CAD-DXF FILES
The CAD-DXF Viewer reads and displays the contents of a Drawing Exchange Format (DXF) file. DXF
files can be created using an off-the-shelf program such as AutoCAD, Turbo CAD, Technical Visio, Drafix,
or MEDUSA. To view a DXF file double click the mouse button on the DXF filename. The viewer allows for
opening and closing of DXF files, changing display resolution, setting zoom ratio, and selecting
background color. It also provides zooming and printing capabilities.

Figure 2.39 DXF Viewer
The status bar at the bottom of the screen displays the X and Y coordinates of the mouse position, the
maximum X and Y coordinates of the drawing, the active tab number and the total number of tabs in the
window. To zoom in or out use the Zoom In
and Zoom Out
menu buttons. To view the drawing
in its original size click the Original Display
menu button, or click the Fit to Window
menu button
to resize the drawing to fit in the window. Use the Open File
menu button to add DXF files to the
window. Click on the Close File
menu button to close an open DXF file.
The Zoom Scalar selectable box
is used to increase or decrease the drawing’s
display resolution. For example, when the Zoom In feature is activated the drawing's X and Y resolution
values are multiplied by the Zoom IN/OUT Ratio to increase the resolution. When the Zoom Out feature is
activated the drawing's X and Y resolution values are divided by the Zoom IN/OUT Ratio to decrease the
resolution.
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The Const
menu button allows for changing the file, the drawing’s display resolution, and the
background color. The dialog fields are described below:
Field
File Name
Background Color
Max X Pixels
Max Y Pixels

Description
The path and the DXF filename. Default: Empty. Use the Browse button to
browse for a file.
The background color for the displayed DXF file. Default: White.
The maximum number of X pixels used to display the DXF file. Enter an
integer value.
The maximum number of Y pixels used to display the DXF file. Enter an
integer value.

Use the tab or shift+tab keys to navigate between fields and the up and down arrow keys to view the
selectable options. Click Apply to view the changes, OK to accept the changes, or Cancel to terminate
the changes.

Figure 2.40 DXF Drawing Constants

VIEWING ASCII FILES IN DATABASE FORMAT
The database viewer provides an effective way to organize, sort, and search comma delimited, double
quoted comma delimited, or tab delimited text files. The data is presented in tabular form, and an unlimited
number of rows and columns can be displayed. The viewer allows for intelligent queries, column sorting,
selecting and grouping data, row deletion, printing, saving and saving in a new file.
Use the column headers to sort the data in ascending or descending order and the query fields to search
the data. Refer to the “Querying Files” section for more information. To browse the data use the up, down,
right, left, page-up, page-down, home, end, ctrl+home, and ctrl+end keys or use the scroll bars. Rows
must be marked in order to delete them from the table.
The database viewer is useful for processing COMTRADE data files, employing under triggers and over
triggers, locating instantaneous maximum and minimum peak values and analyzing load information.
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Figure 2.41 Database Viewer

SHOW/HIDE CHANNEL TITLES
The data plotting window automatically hides channels that contain certain characters in the channel title.
Below is a list of the characters defined as invalid channels when a file is displayed.

















UNUSE
UNDEF
NOT D
NOT U
NOT I
NOT A
{
N/A
ANALOG INPUT
UNTITLED
ANALOG CHANNEL
EXTERNAL INPUT
EVENT CHANNEL
CHANNEL:
DIGITAL TRACE #
SPARE

If a channel title contains the above characters in the beginning of an analog or digital channel title the
channel is automatically hidden. These characters can be modified to show a channel when a file is
displayed. To show a title that contains the above characters select the “Show/Hide Channel Titles…”
menu option under the “Options” menu.
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Figure 2.42 Show/Hide Channel Titles Dialog
To show a title, uncheck the checkbox next to the displayed invalid channel title. To remove a title from the
list select the title in the list box then click the “Remove” button or press the delete key. To add a new title,
first type the new title in the edit box then click the “Add” button. The new title is added to the end of the list
with the checkbox automatically checked.

QUERYING FILES
The query fields are used to search for specific information in the table. Query fields are located below the
table. Use the tab key to move the cursor from the table to the query fields and up arrow to return to the
table. The Ctrl-left/right keys moves between the query fields. Each field contains a criteria and an
operator. The criteria is directly entered from the keyboard, and may include the “*” and “?” wild cards.
Operators are located above the criteria fields and can be changed by clicking the mouse button on the
operator symbol or by pressing the F9 key. The selectable options include equal to (=), less than (<), and
greater than (<).

Figure 2.43 Query Fields
When a query is launched, the engine numerically compares the criteria with the information in the table. If
numerical comparison is not possible, symbolic comparison is performed. When multiple fields are defined,
the engine searches for a match on the first field “AND” on the second field “AND” on the third field and so
on.
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Three query options are available: Query All Files, Query Marked Files, or Query Unmarked Files. Files
that meet the specified query requirements are marked, grouped, and displayed at the top of the table.
Use the Ctrl-left/right keys to navigate through the query fields and the <enter> key to process the query.

DSITURBANCE REPORT
The disturbance report feature creates a comma delimited file that contains the following information for
each file processed (if available in the file):
















Utility Name,
Device Name (Fault),
File Start Date & Time,
Substation Name,
Report Date,
Faulted Phase,
Fault Location,
Line Length,
Fault Current,
Maximum Voltage,
Maximum Frequency,
Minimum Frequency,
Pass/Fail,
Passed Filters and the
Source file's folder and filename.

The disturbance report dialog allows for setting the report's destination folder and filename. It also allows
for setting the folder(s) where the event files are located. The filter section is for setting filter levels for the
Faulted Phase, Fault Location, Current and Voltage thresholds and the deviation for the frequency.
To open the disturbance report dialog, open the “Options” menu in the file manager’s table, select the
“Report” submenu then click on the “Disturbance Report” menu option.

52

Chapter 2 – File Manager Quick Start

Figure 2.44 Disturbance Report Menu
The disturbance report dialog is displayed when the “Disturbance Report” option is selected.

Figure 2.45 Disturbance Report Dialog
The disturbance dialog has 3 sections: Destination Folder & File, Source Folder(s) and Filters. Each
section is explained in the following sections along with the functions for each button.
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DESTINATION FOLDER & FILE:
The Destination Folder & File section is used to set the disturbance report folder & filename. Type the
drive, folder and filename into the "Destination File:" field or use the Browse button to locate an existing file
or for creating a new file and/or folder.

Figure 2.46 Disturbance Report: Destination Folder & File
To save the disturbance information to a new file, click the "Create New File" radio button. This option will
clear the file before processing the event files. To append the disturbance information to the end of an
existing file, click the "Append Existing File" radio button.
FOLDERS:
The Folders section is used for defining where the event files are located. To process files located in the
File Manager's active folder check the "Process Files in the Active Folder" check box. If files are marked in
the active folder, then this feature will process only the marked event files. If there are no marked files then
all the event files are processed.
If the event files are located in different folders then use the "Add" button to add a folder to the Source
Folder list. To remove a folder from the list, use the "Delete" button.

Figure 2.47 Disturbance Report: Source Folder(s)
FILTERS:
The Filters section is used to define the faulted phases, the filter levels for the fault location, voltage class
and fault current levels. It also, defines the deviation of the maximum and minimum frequency values from
the Line Frequency.
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Figure 2.48 Disturbance Report: Filters
After the filters are applied to the data file the file will be tagged with a PASS or FAIL. A PASS means that
the file’s fault type exists in the list AND the fault location is within the entered percentage of the line length
AND the fault current is above the entered fault current value AND the voltage class is above the entered
voltage class value OR the maximum or minimum frequency is above the entered deviation from the line
frequency. The calculations used are listed below:
For files with no Voltage Channels a PASS Equals:
Faulted Phase is in the List of Filter Phase Settings
AND
Maximum Fault Current is > Entered Fault Current Filter
OR
|Maximum/Minimum Frequency Value - Line Frequency| is > Entered Filter Deviation Value
For files with Voltage Channels a PASS Equals:
Faulted Phase is in the List of Filter Phase Settings
AND
Fault Location is < Entered % of the Line Length
AND
Maximum Voltage Value is > Entered Voltage Class Filter
AND
Maximum Fault Current is > Entered Fault Current Filter
OR
|Maximum/Minimum Frequency Value - Line Frequency| is > Enter Filter Deviation Value
Each file in the report also lists the filters that triggered. The 5 columns to the right of the PASS/FAIL
column list the filters that triggered. Each column is labeled according to the filter:
P = Faulted Phase Filter
L = Fault Location Filter
C = Current Filter
V = Voltage Filter
F = Frequency Filter
If a filter triggers then the filter letter is displayed in the columns otherwise it is left blank.
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Figure 2.49 Disturbance Report
The “Process” button starts the disturbance report. Once started the Disturbance dialog is closed and each
file is processed. The progress bar displayed in the button speed bar is updated according to the number
of files to process and the current file being processed.
When the processing is complete a comma delimited table is displayed. The comma delimited table allows
for sorting each column by clicking on the column’s header. The query section located below the table
allows for quickly searching for specific files. Also, the processed files can be displayed by double clicking
on a row or moving the table cursor to the row and pressing enter. The file will be displayed in the analysis
window.
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Figure 2.50 Disturbance Display File
BUTTONS:
There are 5 buttons displayed at the bottom of the disturbance dialog. Each button is explained below:
1. Process Button: The process button starts the disturbance report. The dialog is closed and each file
is processed. The progress bar displayed in the button speed bar is updated according to the number
of files to process and what file is currently being processed.
2. Save Script: All the information displayed in the dialog is saved in a script file located in the folder
where Wavewin is located. The file is called: Disturbance.ini. A message box is displayed confirming
that the information has been saved. The dialog information is also saved to the Disturbance.ini file
when the “Process” button is clicked.
3. Edit Script: The edit script button closes the dialog and displays the Disturbance.ini file in the ASCII
editor.
4.

Show Help: The show help button displays the help information in a note pad below the buttons. The
window size is increased to show the note pad. When the help window is displayed the “Show Help”
button’s text changes to “Hide Help”. To hide the help window click on “Hide Help”.

5. Close: Close the dialog without saving the entered information.

COMPLEX CALCULATOR
The complex calculator is used to perform complex mathematical operations. Operations can be
performed in Polar or Rectangular form. Also, there are 4 memory locations used to store the results of an
operation. To store a result first click on the memory location radio button then click on the down arrow
next to the “Magnitude” edit box. To recall a memory location click on the memory locations radio button
then click on the “Recall” button. The “Clear All” button clears all four memory locations.
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The calculator operates as an HP calculator. After each entry click the “Enter” button to record the values
in the Accumulator.
The complex calculator menu option is listed under the "Options" menu.

Figure 2.51 Complex Calculator

AUTO CONVERT TO COMTRADE
The auto convert to Comtrade dialog is used for defining the properties to automatically convert specific
file types to the IEEE C37.111 Comtrade 1999 format. Auto Convert to Comtrade monitors the entered
“Source Path” for the defined file extensions. When a file is detected it first saves the output Comtrade file
to the defined “Destination Path” then archives the source file to the defined “Archive Path”.
The SEL Sag/Swell/Interruption (SSI) files contain multiple event information stored with big gaps of time
between each event. These files will be scanned for events and each event will be saved in a separate
Comtrade file. To define the boundaries for the SSI files enter then minimum number of cycles required
before saving to Comtrade, the default is 2 cycles. Also, enter the maximum number of milliseconds
between samples before the SSI data is separated into multiple Comtrade files, the default is 50
milliseconds.
To open the auto convert to Comtrade dialog select the "Auto Convert to Comtrade..." menu option under
the "Options" menu in the File Manager. Enter the source path, destination path, archive path, file
extension and the scan period in minutes. Auto convert to Comtrade monitors the Source path for the
defined file extensions every scan period.
To start the process, click on the "Start Convert" button. Once the conversion starts the button caption will
change to "End Convert". To end the conversion process, click on the "End Convert" button. If a file
already exists in the destination path then the file is overwritten. The status of each scan is displayed in the
Status section of the dialog.
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To have the auto convert to Comtrade process started when Wavewin is ran check the “Automatically Start
Convert to Comtrade at Run Time” check box. The conversion process is performed in the background so
the dialog is not required to be open for the process to execute. To check the status of the conversion,
open the dialog. The “Next Scan In” field reports how many minutes before the next scan is started.
Inputs:
Field
Properties:
Source Path
Destination Path
Archive Path
File Extensions
Scan Period
SEL SSI Files
Minimum # of Cycles
Milliseconds Difference

Definition
Path where the original files are located.
Path where the converted Comtrade files are saved.
Path where the original files are archived after they are converted
to Comtrade.
The extension of the files to convert to Comtrade separated by
commas, *.SSI,*.EVE
The scan period in minutes.
The minimum number of cycles required before saving to
Comtrade.
The maximum number of milliseconds between samples before
the SSI data is separated into multiple Comtrade files.
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Figure 2.52 Auto Convert To Comtrade

SHORTCUTS
For easily access to the menu options in the file manager and data plotting window a shortcut drop down
menu button can be configured from the “ShortCuts” dialog. To open the “ShortCuts” dialog open the
“Display” dialog from the file manager’s “Options” menu. Click the “ShortCuts” button.
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Figure 2.53 ShortCut Dialog
There are two tabs, one for the file manager and one for the data plotting window. Click on the tab to
define the shortcuts. Select the menu items using the Ctrl-default mouse button then click the green
“Move” button. All selected menu items will be copied to the User ShortCuts list. To delete menu items
from the User ShortCuts list select the menu item and click the “Delete” button.
To arrange the menu items, select the menu items and click the “Move Up” or “Move Down” buttons. Click
OK to save the shortcuts or “Cancel” to abort the changes.
When the shortcuts are saved a new drop down menu button is added to the appropriate menu bar.

Figure 2.54 ShortCut Menu
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SEARCH FILE CONTENTS
The Search File Contents dialog allows for searching ASCII files for key words and displaying the results
in a table format. To open the dialog open the Files menu then select the Search File Contents menu
option.
This dialog allows for selecting the Start Date, End Date, Search Path, the file extensions to search, the
key strings to search for and the path where the results will be saved. Refer to the following table for more
details on each field:
Field
Start Date:

End Date:
Search Path:
Include Sub Folders:
Extensions:
Search Strings:
Report Path::

Definition
Select the Month Day and Year from the Start Date drop down list
boxes. This defines what files to search in the the defined Search Path
and Included Sub Folder if specified. If the files save date is equal to or
greater than the selected start date and less then or equal to the
selected end date then that file is searched for the entered search
strings.
Select the Month Day and Year from the End Date drop down list boxes.
Enter the Search Path or use the Browse button to the select the path.
To include all sub folders under the Search Path click the Include Sub
Folder check box.
Enter the file extensions to search separated by commas, for example:
*.DTB,*.TXT,*.CSV.
Enter the search string to look for. For multiple search strings separate
each string by a comma, for example: password, logon.
Enter the Report Path or use the Browse button to the select the path.

The Start Date and End Date define what files to search. If a file’s save date is within the start and end
dates than that file is included in the search.
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Figure 2.55 Search File Contents Dialog
The dialog also allows for saving the search fields to an ASCII txt file and for opening existing search files.
Use the Save, Save As and Open buttons to save the active search to the active file listed in the status
field, save the search fields under a new file name or for opening an existing search file. The search fields
are saved to the ASCII text file in an INI file format:
[START DATE]
01\01\2016
[END DATE]
01\01\2018
[SEARCH PATH]
C:\FaultLib\SDCMess
[INCLUDE SUBFOLDERS]
1
[SEARCH FILES]
*.DTB
[SEARCH STRING]
63

Chapter 2 – File Manager Quick Start

password
[REPORT PATH]
C:\FaultLib\SDCMess\Backup
To start the search, click the Search button. If results are found then the results are saved to a CSV file
with the following file name: yymmdd,hhmmss,Search Results,User.CSV. The User field in the file name is
the username defined in the Save and Archive (Properties) dialog or from the Window Active Directory
logon dialog.
The Search Results window section displays the search path, each file being searched and the number of
search items found.
To view the search results click the View Results button. A table is displayed with the following columns:
Field
:Occurance
:File Date
:File Time
:Search String
:Line Number
Line Text:
FileName:

Definition
The occurance number in the listed filename.
The save date of the file.
The save time of the file.
The search string found.
The line number where the search string was found in the file.
The text of the line number number.
The path and filename where the search string exists.

Figure 2.56 Search File Results
To view the file and line number of the search results double click on the table row of the desired search
item. The file will be displayed in an ASCII editor at the specified line number
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AUTO PROCESS TEMPLATES
The Auto Process Templates dialog allows for automatically extracting key information out of waveform
files and saving the extracted information to a CSV file. The CSV file can then be imported into a
database.
The template files to be processed contain script commands that will perform calculations on the voltage
and current channels. For the calculations to work properly the analog channels must be in the right
position. For this, line groups are created. The line groups insure that the voltage channels (Va, Vb, Vc)
are the first 3 channels displayed and the next 4 are the current channels (Ia, Ib, Ic, In). Line groups work
for DFR and Relay file and are associated with Comtrade files.
A main line group file is created for each specific device. The name of the line group file is the first field on
the first line of the Comtrade .CFG file that is produced by the device with a LNG extension.
For example, if a device saves the .CFG files with the station name as the first field on the first line then
the line group file will be StationName.LNG. Any changes to the line groups will be made to the main LNG
file. When Comtrade files are received from the device a new file is created with the same name as the
.CFG and .DAT but with the extension LGP. The LGP is a copy of the LNG file but named to be
associated with the Comtrade file. This allows for a versioning system. It preserves the line group
information for past Comtrade files.
A Line Group defines all of the information needed to view and analyze (manually or automatically) the
data for a specific feeder from an installed DME. The information includes: analog channels, associated
breakers and other digital events, remote end, and line impedance information.
The line group file contains the following information:
[S-D456]
LineName=S-D456
RemoteDME=Bainbrook 345kv
RemoteName=S-E567
VaChan=22
VbChan=23
VcChan=24
IaChan=25
IbChan=26
IcChan=27
InChan=28
Breaker1=1
Breaker2=2
Event1=14
Event2=15
Event3=16
Event4=17
Event5=18
Event6=19
Event7=20
Event8=21
Event9=22
Event10=83
Event11=84
Event12=85
Event13=86
Event14=87
Event15=88
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Event16=89
Event17=90
Event18=91
VaColor=Red
VbColor=Blue
VcColor=Green
IaColor=Red
IbColor=Blue
IcColor=Green
InColor=Fuchsia
PosSeqR=0.46301
PosSeqX=2.50905
ZeroSeqR=5.09427
ZeroSeqX=5.66559
LineMiles=9.9
FromBus=1400
ToBus=1000
Cktnum=50
For relay files a line group file will contain one line group, but for DFR files a maximum of 25 line groups
can exist in one file. Below are definitions for each line in a line group:
Field

Description

Format

LINE NAME

Feeder Designation

Text (up to 12 Characters)

REMOTE DME

Remote DME Designation

Text (up to 24 Characters)

REMOTE GROUP

Remote Feeder Designation

Text (up to 12 Characters)

VA CHAN

VA Analog Channel Number

Integer Number (1 to 255)

VB CHAN

VB Analog Channel Number

Integer Number (1 to 255)

VC CHAN

VC Analog Channel Number

Integer Number (1 to 255)

IA CHAN

IA Analog Channel Number

Integer Number (1 to 255)

IB CHAN

IB Analog Channel Number

Integer Number (1 to 255)

IC CHAN

IC Analog Channel Number

Integer Number (1 to 255)

IN CHAN

Neutral Analog Channel Number

Integer Number (1 to 255)

BREAKER 1

Digital Channel – Breaker 1 Status

Integer Number (1 to 1024)

BREAKER 2

Digital Channel – Breaker 2 Status

Integer Number (1 to 1024)

EVENT 1

Digital Channel – Event 1 Status

Integer Number (1 to 1024)

EVENT 2

Digital Channel – Event 2 Status

Integer Number (1 to 1024)

EVENT N

Digital Channel – Event N Status

Integer Number (1 to 1024)

VA COLOR

VA Channel Color

Text (Example: Red)

VB COLOR

VB Channel Color

Text (Example: Blue)

VC COLOR

VC Channel Color

Text (Example: Green)

IA COLOR

IA Channel Color

Text (Example: Red)

IB COLOR

IB Channel Color

Text (Example: Blue)
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IC COLOR

IC Channel Color

Text (Example: Green)

IN COLOR

Neutral Channel Color

Text (Example: Fuchsia)

POS SEQ R

Real Positive Seq Line Impedance

Real Num (5 Decimal Digits)

POS SEQ X

Imaginary Positive Seq Line Impedance

Real Num (5 Decimal Digits)

ZERO SEQ R

Real Zero Seq Line Impedance

Real Num (5 Decimal Digits)

ZERO SEQ X

Imaginary Zero Seq Line Impedance

Real Num (5 Decimal Digits)

LINE MILES

Total Line Length in Miles

Real Num (2 Decimal Digits)

FROM BUS

CAPE From Bus Designation

Integer Number (up to 9999)

TO BUS

CAPE To Bus Designation

Integer Number (up to 9999)

CKT NUM

CAPE Circuit Number

Integer Number (up to 9999)

Once the line groups are defined then template files can be built to extract key information from the files.
Below is a list of the script commands that can be used in the template files.
Window Commands
<Station>
Writes the full Station name.
<Station:12> Writes the first 12 characters of the Station name.
<Device>
Writes the full Device name.
<Device:6>
Writes the first 6 characters of the Device name.
<Date:F>
Writes the Date at the data bar in the following format mm/dd/yyyy.
<Time:F>
Writes the Time at the data bar in the following format hh:mm:ss.zzzzzz.
<Date:U>
Writes the Date at the data bar in the following format yyyymmdd.
<Time:U>
Writes the Time at the data bar in the following format hhmmsszzz.
<Cycles>
Writes the number of Cycles between the data bar and the reference bar.
<DeltaX>
Writes the time difference between the data bar and the reference bar.
<Line>
Writes the active Line name.
Analog Commands
<>
Write the analog data at the data bar,
[]
Write the analog data at the reference bar,
Number
Writes the visible analog column data at the date bar separated by commas for
specified Channel number.
^Number
Writes the visible analog column data separated by commas for the Channel in
position 1.
:R
Writes the RMS value.
:T
Writes the Channel Title.
:U
Writes the Channel Unit.
:P
Writes the Phase value.
:I
Writes the Instantaneous value.
:F
Writes the DFT magnitude.
:Number
Specifies the width of the analog data values. Will only be applied if the defined
width is greater than the length of the data values. Spaces are padded to the
beginning of the written values. This is use to right justify values.
:S
The skew of the 3 analog channels using the angles. The S command is used
with 3 analog channels <1,2,3:S>. This command adds the 3 angles at the
cursor. One of the channels must be marked as a reference channel.
:B
The Unbalanced Value for 3 Channels. The B command is used with 3 analog
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:N
G
L
Triggers

channels <1,2,3:B>. This command finds the highest and lowest DFT magnitude
of the 3 channels. The result is the highest – lowest.
Negative Sequence of the channels defined before the N command.
Writes Alarm if the previous command was greater than the specified value
following the G command. If the value is not greater than it writes Normal.
Writes Alarm if the previous command was less than the specified value
following the L command. If the value is not greater than it writes Normal.
Counts the number of trigger exceeded from the G and L Commands.

Example Analog Commands
<1>
Writes the visible analog column data at the date bar separated by
commas for Channel 1.
<^1>
Writes the visible analog column data separated by commas for the
Channel in position 1.
<1:R>
Writes the RMS value at the data bar for Channel 1.
<2:T>
Writes the Channel Title for Channel 2.
<^3:U>
Writes the Channel Unit for the Channel in position 3.
<4:P>
Writes the Phase value for channel 4.
<^5:I>
Writes the Instantaneous value for the Channel in position 5.
<6:F>
Writes the DFT magnitude for Channel 6.
[^1]
Writes the visible analog column data at the reference bar separated by
commas for Channel 1.
<^1,^2,^3:S>
Writes the sum of the angles at the cursor bar. One of the 3 channels
must be marked as a reference channel.
[^1,^2,^3:B]
Writes the difference between the highest and lowest DFT magnitude at
the reference bar.
<^1,^2,^3:N:6>
Writes the negative
<^1,^2,^3:NG2000:7> Writes Alarm if the negative sequence of the 3 channels in position 1, 2
and 3 is greater than 2000, if it is not greater than it writes Normal.
<^1,^2,^3:NL500:7>
Writes Alarm if the negative sequence of the 3 channels in position 1, 2
and 3 is less than 500, if it is not less than it writes Normal.
To open the Auto Process Template dialog open the Options menu then select the Auto Process
Templates menu option.
The dialog allows for 5 templates to be processed at one time. Enter or select the template files in the
template fields. Enter or select the report path where the report files are saved. Select the type of files to
process. The All Files option will process all the files in the active path and included sub folder if the option
is specified. After a file is processed a WWD is added to the last field in the long filename. This tags the
file as processed. To only process new files select the New Files option.
If files are marked in the active path the Process Only Marked Files check box will be enabled. Click this
option to process only the marked files. To include all the sub folders under the active path, click the
Include Sub Folder check box.
To start the process, click the Run button. When the Run button is activated the fields in the dialog will be
saved and the dialog will be closed. Each specified file will be opened in the analysis window, the Mark
and Save window will be opened and each line group will be selected in the file. The template fields will be
processed for each line group and saved to the appropriate report file. The report files are saved to the
specified report path and each report file will have the same name as the template file with a .DIG
extension.
To view the report files navigate to the report path and double click on the .DIG files. The report will be
displayed in table. To plot the file with the specified line group double click on the desired row.
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Figure 2.57 Auto Process Templates
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Analysis Quick Start
This chapter describes the main features of the Analysis Display.

Analysis Features
The Analysis Display offers a high-resolution graphical interface for displaying, analyzing, and manipulating
analog and digital channels of an oscillography record or a periodic load file. Displayed channels can be
marked, merged, appended, moved, zoomed, removed, restored, superimposed, scaled, numerically
processed, exported and summarized. A maximum of ten data windows can be opened at one time.

Figure 3.1 Analysis Display
The Analysis Display contains two sections: the analog view and the digital view. The analog view plots the
oscillography or load data. The analog table displays values such as the channel’s highest peak, RMS,
phase, reference, instantaneous, maximum, and minimum values. The cursor bars are used to view the data
values. The digital view plots the events and sensors and displays the channel’s original state, the channel’s
final state, time of the first change, time of the last change, and the number of times the channel changed
state.
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Up to 256 analog and 2048 digital channels can be displayed in the window. A maximum of 10 data
windows can be opened at the one time. The main features are described below.

PHASORS
The phasor diagram shows a vector for each visible analog channel. It also shows a vector at the
reference bar for the first channel or the first marked channel, if the option is selected. To show the vector
at the reference bar select the “Reference Vector” menu option under the “View” menu.
The vector diagram is displayed to the right of the analog information window. To increase or decrease the
size of the phasor window place the cursor over the vertical separator between the analog information
window and the phasor window and drag the mouse to the left to increase or to the right to decrease. To
close the phasor window click the close button located in the header. To reopen the phasor window select
the “Phasor/Circular Chart Window” menu option under the “View” menu or position the mouse over the
analog channels scrollbar displayed to the right of the analog channel table and move the mouse until the
cursor becomes a double arrow. When the cursor changes to a double arrow drag the window to the left to
reopen the window.
To navigate the phase angles use the left arrow, right arrow, home, end, page up and page down keys or
the data scroll bar. To increase/decrease the length of a channel's vector, mark the channel and use the
increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys. To increase/decrease only
the length of the vectors, use the up and down phasor buttons.
To toggle between the phasor display and the circular chart display click the “P” button above the phasor
display for phasors or the “C” button for a circular chart.
There are two types of phasor displays: non-referenced and referenced. The non-referenced display
shows the phase angle for each sample in the display. The reference display shows the phase angle for
each sample with respect to the reference channel. The reference channel is the first marked channel in
the window. All angles at a sample are subtracted from the reference angle. If there are no marked
channels the non-referenced display is shown.

Figure 3.2

(a) Non-Referenced Phasors

(b) Referenced Phasors

HARMONICS
The harmonics window displays as many harmonics as possible based on the file’s sampling frequency. A
maximum of 200 harmonics can be displayed in the table. To display the harmonics window right click in
the phasor diagram or in the analog information table and select the Harmonics menu option. The
harmonics window displays the first marked analog channel or if no channels are marked, the first visible
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channel. Changing the marked channel in the data plotting window will update the harmonics window with
the appropriate channel.
The harmonic calculation is performed on a one cycle window, starting at the RMS bar and going forward
to the data bar. There are three fields displayed at the bottom of the harmonics table and histogram;
TrueRMS, CalculatedRMS and Total Harmonic Distortion (THD). The TrueRMS field displays the RMS
value calculated by using the samples in the active cycle displayed in the waveform trace window. The
CalculatedRMS field displays the square root of the summation of the squares of the DFT Magnitudes
from harmonics 2 to the maximum harmonic divided by square root of 2. The maximum harmonic is the
number of samples per cycle divided by 2. The THD field displays the square root of the summation of the
squares of the DFT Magnitudes from harmonics 2 to the maximum harmonic and that quantity divided by
the DFT Magnitude of the Fundamental.
The harmonics can be viewed in a table format or in a histogram. Click on the harmonics toggle button
to change the view. The histogram can show only one column from the table. To change the data
displayed click the histogram drop down menu and select the column. The default view is the % of
Fundamental.

.
Figure 3.3 Histogram Drop Down Menu
The harmonic histogram bars can be resized using the resize up and down arrows
to display
more or less harmonics in the window. The text displayed above the histogram bars can be shown or
hidden be clicking on the Show/Hide text bar button
. The harmonics window can be resized by
dragging the edge of the window to show more or less harmonics per window.
th

Also, a vector for each harmonic is displayed in the phasor diagram, up to the 11 harmonic. To hide/show
the harmonic vectors toggle the "Vector Harmonics" menu option under the "View" menu from checked=on
to unchecked=off.
th

The 0 harmonic represents the percentage of DC offset in the channel.
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Figure 3.4 Harmonics Table View

Figure 3.5 Harmonics Histogram View

PERIODIC LOG FILES
The periodic log viewer allows for viewing and analyzing large amounts of event data in a single display.
The data is displayed in envelope form and may contain one day, one week, one month or one year of
event data. This feature is useful for load flow analysis.
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A circular chart of the data displayed in the trace window is plotted to the right of the channel information
window. The circular chart cursor is positioned on the sample at the waveform data bar. The duration of
the data displayed also is shown below the circular chart along with the sample number at the cursor bar.
The ABB Load Profile and SDC log drivers are specific drivers used to view periodic log data. The
COMTRADE format also displays log data. The ABB Load Profile format is an ASCII text file that contains
time sequenced load information. The SDC Log format is an ASCII comma delimited CSV text file. The
first line of the file is the header information. These files are generated from the Fault Data Concentrator
(FDC).

Figure 3.6 Periodic Log File

CIRCULAR CHART
The Circular Chart diagram shows a circular display for each visible channel. The diagram is displayed to
the right of the analog information window. The amount of data displayed in the circular chart is equal to
the amount of data displayed in the waveform trace window. The duration of the data displayed is shown
at the bottom of the circular chart. To increase or decrease the size of the circular chart window place the
cursor over the vertical separator between the analog information window and the circular chart window
and drag the mouse to the left to increase or to the right to decrease. To close the circular chart window
click the close button
located in the header.
To navigate the circular chart use the left arrow, right arrow, home, end, page up and page down keys or
the data scroll bar. The cursor bar on the circular chart displays where the data bar is in the plot. To
increase/decrease the display area of a channel on the circular chart, mark the channel and use the
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increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys or use the up and down
arrow button
located in the circular chart header.

Figure 3.7 Circular Charts

DISPLAY DRIVER’S DATA TYPE
The data stored in the displayed file can be instantaneous values or RMS values. The default setting for all
drivers is instantaneous values. If the display driver saves the sample values as RMS calibrated, set the
display driver’s data type to RMS Type (Root 2 Multiplier). If the display driver is not set properly the
analog column data will be displayed incorrectly. To set the driver’s data type click the “Window
Properties”
menu button from the speed bar or select the “Window Properties” option under the
“File” menu. Click the “Driver Data Type” tab and set the “Display Device’s Data Type” field to “RMS Type”
for RMS calibrated values and “Peak Type” for instantaneous values.
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Figure 3.8 Analog Data Type Setting

REOPEN WAVEFORM FILE
To reopen a waveform file that was previously viewed click the reopen menu button
of the files from the drop down list.

and select one
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Figure 3.9 ReOpen Data File

EMAIL ACTIVE FILE
The active data file can be emailed by clicking on the email
menu button or by selecting “Email Active
File” from the “File” menu. The data file displayed and all the support files associated with the file are
included as attachments. The users default email program will be displayed to email the file(s).

NAVIGATING
Use the up and down arrow keys or the vertical scroll bar to browse the analog channels. The tab key
toggles between the analog and digital views.
The analog and digital values are displayed in a table to the right of the channel traces. Hold the mouse
button down and drag the table separator bars to resize the viewing area. To view the analog sample
values use the following navigation tools:









Left and right arrow keys to navigate sample by sample.
Ctrl+left or ctrl+right keys to peak navigate.
Shift+ctrl+left or shift+ctrl+right keys to cycle hop.
Home and end keys to display the channel’s first and last samples.
Triangle at the bottom of the data bar to drag the data bar through the samples.
Page up and page down keys to page through the samples.
Left button
displayed to the left of the data scroll bar to move the sample at the data bar to the
position of the first sample displayed.
Left button
displayed to the right of the data scroll bar to move the trace and table separator to
the position of the data bar.

Click the left/right arrow button
(located to the right of the analog table headers) or use the shiftright/left arrows to scroll through the analog table columns. Refer to the “Viewing Analog Data” section for
field descriptions.
NOTE: If no channels are marked then the peak navigate and cycle hop features navigate through the first
channel’s data.
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SETTING THE CURSOR BARS
Four vertical cursor bars are displayed in the analog view. The blue dotted line represents the reference
bar, the black solid line represents the data bar, the black dotted line represents the RMS bar and the red
dotted line represents the fault position defined in the file’s configuration information. There are also two
horizontal bars displayed when the “Horizontal Bars” menu option under the “View” menu is checked.

DATA BAR
The data bar is displayed as a black solid line with a white triangle below the line. The position of the
data bar is defaulted at the end of the first cycle in the data window when it is first displayed. To set the
data bar’s position to 2 cycles after the trigger position set the “Auto Set Data Bar” menu option in the
“View” menu.
To move the data bar use the left and right arrow keys to move one sample, use the Ctrl-left and Ctrlright keys to peak hop, use the Shift-Ctrl-left and Shift-Ctrl-right keys to cycle hop, use the page up and
page down keys to move one page up or down or left click the mouse to move to any position in the
data or drag the triangle to scroll through the data. When the mouse is held over the triangle a hint
message displays the sample number at the data bar and the delta time from the first sample. The time
of the sample at the data bar is displayed in the second status bar field. The channel values at the data
bar are displayed to the right of the traces in the analog channel information table.

REFERENCE BAR
The reference bar is displayed as a blue dotted line. The reference bar is defaulted to the fault time
specified in the file. To move the reference bar to the position of the data bar use the "Move Reference
Bar to Data Bar" option inside the “View” menu or press Ctrl-A or click the SetRef menu button
.
Click the opposite mouse button to move the reference bar to any position in the data area. The status
field Delta X in the status bar at the bottom of the screen shows the time difference (in milliseconds or
seconds) between the reference bar and the data bar. It also shows how many cycles are between the
two bars.

RMS BAR
The RMS bar is displayed as a black dotted line. The RMS bar is defaulted to one cycle away from the
data bar, except when the data bar is positioned at the beginning of the data. This bar is used for
calculating the RMS value displayed in the analog information table. The RMS value in the analog table
is calculated using all of the sample values displayed between the data bar and the RMS bar. To move
the RMS bar to the position of the reference bar (blue dotted line) use the "Move RMS Bar to
Reference Bar" option inside the “View” menu or press Ctrl-Z or click the SetRMS
menu button.

FAULT BAR
The fault bar is displayed as a red dotted line. The fault bar is fixed and positioned at the fault time
defined in the file’s configuration information. The fault bar can be shown or hidden by selecting the
“Yes” or “No” options for the “Show Vertical Fault Bar” field in the properties dialog under the “Display
Settings” tab.

HORIZONTAL BARS
When the “Horizontal Bars” menu option under the “View” menu is checked two horizontal bars will be
displayed. The solid black line follows the data bar and the dotted blue line follows the reference bar.
The bars will be positioned at the first marked analog channel (displayed in red), if no channels are
marked, then they are positioned at the first displayed channel. The Delta Y field in the status bar
shows the difference between the two bars.
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To automatically resize the RMS sliding window click on the Resize Sliding Window menu button
or
open the “Set Sliding Window Size” dialog from the “View” menu. To manually resize the RMS sliding
window click the opposite mouse button to set the reference position and the mouse button to set the data
bar position then click the SetRMS
menu button. The RMS bar is moved to the reference position.
The Delta X field displayed in the status bar at the bottom of the screen shows the time difference (in
milliseconds or seconds) between the date bar and reference bar and the number of cycles between the
two bars. Use the left, right, ctrl+left, and ctrl+right, shift+ctrl+left, and shift+ctrl+right keys or the horizontal
scroll bar to move the sliding window.

Figure 3.10 Resize Sliding Windows Drop Down Menus

Figure 3.11 Resize Sliding Dialog for Waveforms

Figure 3.12 Resize Sliding Windows Dialog for Log Files

AUTO SET DATA BAR
The data bar (black solid line) is by default positioned one cycle from the first sample when the window is
first displayed. To change the default to be 2 cycles from the trigger position set the “Auto Set Data Bar”
menu option under the “View” menu. The “Auto Set Data Bar” menu option is an on/off feature. The menu
is checked when the feature is on and unchecked when off.
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MARK AND SAVE
The Mark and Save feature saves selected analog data to a user defined ASCII file using the selected
template file. To open the Mark and Save window select the Mark & Save Window menu option under the
Values menu. The window is divided into two sections. The top section displays the contents of the
selected template file in a notepad editor and contains a drop down list to select the template file. The list
is initially populated with all the files that have a *.FMT extension and are located in the Wavewin
directory. A browse button is available to add template files to the list that are not located in the Wavewin
directory. To save a new template file, edit the contents of the existing template file, change the name of
the file using the list box’s edit box then click the Save button.
The bottom section displays the contents of the values file in a notepad editor and the location and name
of the file. To save the analog data to a new file change the name of the file using the edit box or use the
Browse button to create a new file, then click the Save button.

Figure 3.13 Mark and Save Window
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The Apply Unit Prefix will multiply all analog values by 1000 if the values are in kilo. The truncate Values
will save only integer values.
The Use Default checkbox will write the visible analog columns to the Values notepad with a header for
each column.
Before savings values to an ASCII file the template files must be created. Refer to the next section on how
to create a Template file.

TEMPLATE FILES
To create a new template file clear the contents of the existing template file in the notepad editor, change
the name of the template file using the list box’s edit box then click the Save button. To clear the contents
of the Template notepad editor mark the contents of the editor then press the delete key.
To save any changes made to the active template file click the Save button.
The template files use < > characters to define the available window commands and < > and [ ] characters
define the analog commands. Review the Template Commands section for the supported Window and
Analog commands.
To add a header to the Values file, define the first line in the template file with <Header>= followed by the
header information. For example, the following two lines define the header and data of the Values file:
<Header>= Station, Device, Date, Time, RMS, Angle
<Station>, <Device>, <Date>, <Time>, <^1:R>, <^1:P>
Any text not in the < > and [ ] characters get written to the Values file as they appear in the template file.
Below is an example of a template file.
% Initial Postfault Quantities
save
save
save
save
save
save
save

rect(
rect(
rect(
rect(
rect(
rect(
rect(

<1>
<2>
<3>
<4>
<5>
<6>
<7>

)
)
)
)
)
)
)

as
as
as
as
as
as
as

P_Ia
P_Ib
P_Ic
P_In
P_kVa
P_kVb
P_kVc

Results of the values saved using the above template when only the RMS and Phase columns are visible
in the data plotting analog table.
% Initial Postfault Quantities
save
save
save
save
save
save
save

rect(
rect(
rect(
rect(
rect(
rect(
rect(

1096.346,172.477 ) as P_Ia
577.000,24.181 ) as P_Ib
3168.159,38.157 ) as P_Ic
3024.967,50.501 ) as P_In
219759.479,328.716 ) as P_kVa
209623.595,209.628 ) as P_kVb
174040.116,78.700 ) as P_kVc
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TEMPLATE COMMANDS
Window Commands
<Station>
Writes the full Station name.
<Station:12> Writes the first 12 characters of the Station name.
<Device>
Writes the full Device name.
<Device:6>
Writes the first 6 characters of the Device name.
<Date:F>
Writes the Date at the data bar in the following format mm/dd/yyyy.
<Time:F>
Writes the Time at the data bar in the following format hh:mm:ss.zzzzzz.
<Date:U>
Writes the Date at the data bar in the following format yyyymmdd.
<Time:U>
Writes the Time at the data bar in the following format hhmmsszzz.
<Cycles>
Writes the number of Cycles between the data bar and the reference bar.
<DeltaX>
Writes the time difference between the data bar and the reference bar.
<Line>
Writes the active Line name.
Analog Commands
<>
Write the analog data at the data bar,
[]
Write the analog data at the reference bar,
Number
Writes the visible analog column data at the date bar separated by commas for
specified Channel number.
^Number
Writes the visible analog column data separated by commas for the Channel in
position 1.
:R
Writes the RMS value.
:T
Writes the Channel Title.
:U
Writes the Channel Unit.
:P
Writes the Phase value.
:I
Writes the Instantaneous value.
:F
Writes the DFT magnitude.
:Number
Specifies the width of the analog data values. Will only be applied if the defined
width is greater than the length of the data values. Spaces are padded to the
beginning of the written values. This is use to right justify values.
:S
The skew of the 3 analog channels using the angles. The S command is used
with 3 analog channels <1,2,3:S>. This command adds the 3 angles at the
cursor. One of the channels must be marked as a reference channel.
:B
The Unbalanced Value for 3 Channels. The B command is used with 3 analog
channels <1,2,3:B>. This command finds the highest and lowest DFT magnitude
of the 3 channels. The result is the highest – lowest.
:N
Negative Sequence of the channels defined before the N command.
G
Writes Alarm if the previous command was greater than the specified value
following the G command. If the value is not greater than it writes Normal.
L
Writes Alarm if the previous command was less than the specified value
following the L command. If the value is not greater than it writes Normal.
Triggers
Counts the number of trigger exceeded from the G and L Commands.
Example Analog Commands
<1>
Writes the visible analog column data at the date bar separated by commas
for Channel 1.
<^1>
Writes the visible analog column data separated by commas for the Channel
in position 1.
<1:R>
Writes the RMS value at the data bar for Channel 1.
<2:T>
Writes the Channel Title for Channel 2.
<^3:U>
Writes the Channel Unit for the Channel in position 3.
<4:P>
Writes the Phase value for channel 4.
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<^5:I>
<6:F>
[^1]
<^1,^2,^3:S>
[^1,^2,^3:B]
<^1,^2,^3:N:6>
<^1,^2,^3:NG2000:7>
<^1,^2,^3:NL500:7>

Writes the Instantaneous value for the Channel in position 5.
Writes the DFT magnitude for Channel 6.
Writes the visible analog column data at the reference bar separated by
commas for Channel 1.
Writes the sum of the angles at the cursor bar. One of the 3 channels must be
marked as a reference channel.
Writes the difference between the highest and lowest DFT magnitude at the
reference bar.
Writes the negative
Writes Alarm if the negative sequence of the 3 channels in position 1, 2 and 3
is greater than 2000, if it is not greater than it writes Normal.
Writes Alarm if the negative sequence of the 3 channels in position 1, 2 and 3
is less than 500, if it is not less than it writes Normal.

When a carat ^ is specified before the channel number it indicates the channel position in the data plotting
window. The < > characters saves the analog data at the data bar and the [ ] characters saves the analog
data at the reference bar.

VALUE FILES
To create a new values file click the Clear button to clear the contents of the existing values file in the
notepad editor, change the name of the file using the edit box or click the Browse button to create a new
file, then click the Save button.
To write a template command to the values file, first position the data and/or the reference bar in the data
plotting window then click the Mark button in the Mark and Save window or select the Mark Scan menu
option under the Values menu in the data plotting window. You can also use the shortcut keys Ctrl-S to
mark an analog scan in the data plotting window. Each command will be appended to the values notepad
window. Click the Save button to save any changes to the template and values file.
To navigate to the next Marked Scan in the data plotting window select the Next Marked Scan menu
option under the Values menu or use the shortcut keys Ctrl-X to navigate to the next Marked Scan.
The analog commands listed in the Template file section specifies what values to write to the values file. If
the analog channel commands defined in the active template file does not specify a specific data value
then all the analog columns visible will be saved with each command separated by commas. For example
if the analog channel command is <1> and the INST, RMS and PHASE columns are visible then it will
write the INST,RMS,PHASE values for Channel 1.
If a specific analog channel is defined in the template file with no data value indicated and the channel is
not visible then that template command is ignored.
When a template command is written to the values file editor a red upside down T is displayed above the
analog scan in the data display window. To clear the red marks from the data display window select the
“Clear Marked Values” menu option under the “Values” menu.

MARK SCAN
To mark a scan, place the data bar at the desired scan then select the Mark Scan menu option under the
Values menu or press Ctrl-S. Marked scans are tagged with an upside down red T at the top of the scan.
Scans are also marked when the Mark button is clicked in the Mark & Save dialog. Marked scans are
useful for navigating large amounts of data. To quickly navigate through the marked scans select the Next
Marked Scan menu option under the Values menu or press Ctrl-X. To clear the marked scans, select the
Clear Marked Scans menu option under the Values menu. Marked scans can also be tagged with a
comment. Refer to the next section for more information on assigning a comment to each scan.
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EDIT MARKED SCANS
To assign a comment to each marked scan select the Edit Marked Scans menu option under the Values
menu. The edit marked scans dialog is displayed. The dialog lists each marked scan in a table with the
following columns:
Scan Sample Number – Displays the Scan Sample number with a checkbox to the left of the Sample #.
Date & Time
– Displays the date and time of the scan.
Comments
– Allows for entering a comment for each Marked Scan.
The assigned comment can be viewed in the analysis window by placing the mouse over the scans upside
down red T indicator. The comment is displayed in a hint window.
To delete a scan click the checkbox in front of the scan then click the Delete button.

Figure 3.14 Edit Marked Scans

MARKING, DELETING, AND RESTORING CHANNELS
To mark or unmark a channel, mouse click on the channel ID or channel title, or use the space bar. To
mark a group of channels click on the first channel then shift click on the last channel. Marked channels
are displayed in red.
To mark/unmark all analog and digital channels press the F8 key or select the “Mark/UnMark All” menu
option under the “Channels” menu option. If no channels are marked, all of the analog and digital channels
will be marked. If any channels are marked, all of the channels will be unmarked. To mark/unmark all the
analog channels select the “Analog Mark/Unmark All” menu option under the “Channels” menu. To
mark/unmark all of the digital channels select the “Digital Mark/Unmark All” menu option under the
“Channels” menu.
Channels must be marked to delete them from the display window. The Delete key removes the marked
channels and the Insert key restores all the deleted channels.

SCALING ANALOG CHANNELS
When the analysis display is first opened, all the analog channels are scaled according to the channel’s
units. To scale the channels according to the maximum space allocated for display, press F6 or click the
AutoScale
menu button. This option toggles among the four views: On, Off, ++ and Units. The active
auto scale state is displayed in the “AS” status field. Each view is defined below:
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ON – The On view plots the channel data scaled to the maximum value allocated along the zero
reference line.
OFF – The Off view plots all of the channels that are scaled to the maximum value in the display.
++ - The ++ view plots the signal using the number of maximum pixels allocated for the channel.
The highest value is plotted at the maximum position and the smallest value is plotted at the
lowest position. This feature was added to clearly show the profile of a frequency channel, a Vdc
channel and load data channels.
Units – The Units view plots the channels with reference to the maximum value allocated along
the zero reference line for each group of channels with the same units.

To increase or decrease a channel’s amplitude, along with the phasors and circular chart first mark the
channels then click the AmpUp
or AmpDn
menus buttons or use the ctrl+up/down arrow keys. The
auto scale multiplier (ASM) is used to amplify or attenuate the channel’s data values. For example, when
the amplitude increases the ASM value is multiplied by the channel’s current “Pixsdisp” and when the
amplitude decreases the ASM value is divided by the channel’s current “Pixsdisp”. To change the ASM
value, select the “Properties” menu option under the “File” menu then click the “Display Settings” tab, enter
a number and click OK. This value is initially defaulted to 2.00. To increase/decrease only the analog
channels amplitude, click the up and down arrow buttons
located to the right of the data scroll bar.
To increase/decrease only the phasor magnitude or circular chart click the up and down arrow buttons
located in the phasor/circular chart header.
To increase or decrease the channel’s time scale, click the Condense
or press the ctrl+page up and ctrl+page down keys.

or Expand

menu buttons

NOTE: If no channels are marked all the visible channels are scaled accordingly.

ZOOMING CHANNELS
To zoom in on specific analog or digital channels, first mark the channels then press <enter> or click the
ViewMrks
menu button. The unmarked channels are removed from the display window and the
marked channels are rescaled to fit in the window. To restore the hidden channels press the <esc> key,
the <backspace> key, or click the ViewAll
menu button.
When returning to the original view all channels in the previous view remain marked for quick selection of
additional channels for a new view.

SELECTING PREDEFINED VIEWS
The DFR Transcan and Faxtrax records have predefined views encoded into their format. To select the
predefined views click on the “Show All/ Select View” drop down menu button
or select the “Select
Views” menu option under the “View” menu. A list of the available lines/graphs will be displayed. Click on
the desired view. The analog channels defined in the select view will be displayed. To view all the analog
channels in the file press the <esc> key, the <backspace>, or click the “Show All” menu button or click the
ViewAll
menu button. To view user defined views refer to the “User Views” section.
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Figure 3.15 Predefined Lines

Figure 3.16 Predefined Graphs

REPOSITIONING CHANNELS
Analog channels can be repositioned in the display window. To move an analog channel up one position
mark the channel and press the “+” key or select “Shift Marks Up” from the “Channel” menu. To move a
channel down one position mark the channel and press the “-” key or select “Shift Marks Down” from the
“Channel” menu. To move a group of analog channels, mark all the desired channels then press the “+” or
“-“ keys.
The marked analog channels can also be move by dragging the channels to a specific location in the
display. To drag the analog channels position the mouse over one of the marked channels channel
number and drag to the specific position.

PRINTING WAVEFORM FILES
To print all of the data for the visible channels, select “Print/All” from the File menu. The page numbers are
located on the top right corner of each printout. The date and time of the first sample on each page is
printed at the bottom left corner. To print only the data currently displayed in the data window select
“Print”/“Page” from the File menu. To print a screen dump select “Print”/”Window”. Use the zoom feature to
print only the selected channels. If the software cannot access the printer port, an error message is
displayed.

SAVING AS COMTRADE
The visible analog and digital channels can be saved in the COMTRADE ASCII or Binary format. Three
Comtrade versions are supported: the older 1991 format, the 1999 format and the newest 2013 format.
The new 2013 Comtrade format can be saved as a single file with the CFG, HDR and DAT all contained in
the single file. The new Comtrade single file format has a .CFF extension. The default format is the 1999
format.
Mark the analog and digital channels to save and press <enter> or click the ViewMrks menu button
.
To create a COMTRADE file select the “Save as”/”COMTRADE” (ASCII or Binary) menu option from the
“File” menu. Enter the destination path and filename (do not define the filename extension) and click OK.
The “.DAT” and “.CFG” files or the .CFF file are automatically created. If a path is not defined, the
COMTRADE files are saved in the active directory.
To automatically name the Comtrade file using the IEEE long file naming format check the “Use the
ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As Comtrade” dialog and
leave the “File Name” field empty. The selected channels are converted to the specified Comtrade format
and are named using the IEEE long file naming convention.
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If the sample values in the displayed file are RMS calibrated and the outcome Comtrade file must have
instantaneous values, set the “Comtrade Settings” fields to automatically convert the RMS data to
instantaneous values. To set the “Comtrade Settings” fields open the “Properties” dialog. Select the
“Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak Data”.

Figure 3.17 Save As COMTRADE

VIEWING ANALOG DATA
The values displayed in the analog view can be presented in tabular form (analog table) or in a
concentrated form (combination view). Press F4 to toggle between the two views. The concentrated view
can only be displayed if there is enough room to display 2 lines of data values between each channel. To
navigate through the analog table columns use the View
button (located to the right of the analog table
headers) or the shift-right/left arrow keys. To close the analog table, click the Close button located in the
header. Valid analog channels are displayed in the left portion of the window and the analog information in
the center table. An analog channel is marked as invalid if the title is empty, or it contains any of the
following strings in the beginning of the title.

















UNUSE
UNDEF
NOT D
NOT U
NOT I
NAT A
UNDEF
{
N/A
ANALOG INPUT
ANALOG CHANNEL
EXTERNAL INPUT
EVENT CHANNEL
CHANNEL
DIGITAL TRACE #
SPARE

To show an invalid channel use the “Show/Hide Channel Title” dialog in the file manager. Refer to the
“Show/Hide Channel Title” section for usage.
A maximum of 256 analog channels can be displayed in one window. The values displayed in the analog
table and combination view are described below.
Analog Table View:
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The analog table view is the default view. Use the view button
or the shift-right/left arrow keys to
navigate through the columns of the table. The original sample values are plotted according to one of the
following data types:




Peak to Peak data
RMS Calibrated data
Log files.

All of the display drivers in the system are defaulted to peak to peak except the predefined log drivers. To
change the settings for a driver select the "Window Properties" option under the "File" menu. Click on the
"Driver Data Type" tab and select the type from the "Data Multiplier Type" drop down list. Periodic Log
File’s data type cannot be changed.
The following tables describe the analog data for the sinusoidal peak-to-peak, non-sinusoidal, and
sinusoidal RMS data types:
Peak to Peak
Field
Title
RMS

InstPeak
Phase
InstVal
RefVal
MaxPeak
MinPeak
Units
Scale
DFT Peak
Crest

Description
The analog channel titles.
The TrueRMS value is calculated by taking the summation of the square of
all the sample values that are between the RMS bar (black dotted line) and
the data bar. The result is divided by the total number of samples between
the two bars and takes the square root of that result.
The highest absolute value of all of the samples between the two zero
reference crossings surrounding the data bar (black solid line).
The phase angle of each channel.
The sample value at the data bar (black solid line).
The sample value at the reference bar (blue dotted line).
The maximum peak value of the channel.
The minimum peak value of the channel.
The analog channels prefix and units.
The value in units per inch or centimeters.
The DFT Magnitude calculated between the RMS bar (black dotted line)
and the data bar (solid data bar).
The DFTMag column divided by the RMS column.

Sinusoidal RMS Calibrated
Field
Description
Title
The analog channel titles.
RMS
The RMSVal column calculates an RMS value for all of the samples
between the RMS bar (black dotted line) and the data bar (black solid line).
Since the data is RMS calibrated each sample value is multiplied by the
square root of 2 before it is squared.
InstPeak
The square root of 2 multiplied by the peak value measured between the
two reference crossings surrounding the data bar (black solid line).
Phase
The phase angle of each channel.
InstVal
The RMS sample value at the data bar (black solid line) multiplied by Root
2.
RefVal
The RMS sample value at the reference bar (blue dotted line) multiplied by
Root 2.
MaxPeak
The RMS maximum peak value of the channel multiplied by Root 2.
MinPeak
The RMS minimum peak value of the channel multiplied by Root 2.
Units
The analog channels prefix and units.
Scale
The value in units per inch or centimeters
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Field
DFT Peak
Crest

Description
The DFT Magnitude calculated between the RMS bar (black dotted line)
and the data bar (solid data bar).
The DFTMag column divided by the RMS column.

Non-Sinusoidal (Load Files)
Field
Description
Title
The analog channel titles.
MaxWin
The absolute maximum value between the sliding window bar (black dotted
line) and the data bar (black solid line).
InstVal
The sample value at the data bar (black solid line).
RefVal
The sample value at the reference bar (blue dotted line).
MaxVal
The maximum value of the channel.
MinVal
The minimum value of the channel.
Units
The analog channels prefix and units.
Scale
The value in units per inch or centimeters
AvgWin
The average value of all of the samples between the sliding window bar
(black dotted line) and the data bar (black solid line)
Combination View:
The combination view shows all of the channel information in a signal view. This view is only available if
there is sufficient room between analog channels to display two or more lines of text.
Default Display format:
Peak to Peak:
Channel Title
RMS
InstVal

MaxPeak
MinPeak

RefVal
Units

ASV

RMS Calibrated:
Channel Title
RMS
InstVal

MaxPeak
MinPeak

RefVal
Units

ASV

Load Files:
Channel Title
MaxWin
InstVal

MaxVal
MinVal

RefVal
Units

ASV

The peak sample values are displayed in red when the data bar is on the channel’s maximum value and
displayed in blue when the data bar is on the channel’s minimum value. Use the Tab key to toggle
between the analog and digital channels. To hide the channel information, select the "Channel
Information" menu option from the "View" menu.
The analog table and combination views can be resized by selecting the vertical separator bar and
dragging it to the right or left. The mouse icon changes to the vertical resize cursor when the mouse is
positioned over the separator bar.
To change how the analog data is displayed in the analog table and combination view select the
"Properties" menu option from the "File" menu or click on the “Properties”
menu button from the
speed bar. The “Analog Table” tab and the “Analog Combination” tab allows for changing the appearance
of the analog information window.
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Some of the functions of the “Properties” dialog are reordering, hiding, and showing the analog table
columns; changing the data positions in the combination view; changing the background colors and trace
colors; and for changing the drivers data type and trace/phasor scale multipliers.

VIEWING DIGITAL DATA
The default digital view consists of only the triggered digital channels, which are displayed at the bottom of
the screen. To view all of the digital channels including the unused channels press F9 or select “All Digital
Channels” from the “View” menu. A maximum of 2048 digital channels are displayed in a window.
The digital trace is displayed as a thin black line when the sample value equals the original state defined in
the displayed format and is displayed as a thick green line when the sample value differs from the original
state. The Cursor State column in the digital table displays an “A” for Alarm and “N” for Normal or the SEL
defined state. These values are set by comparing the sample value at the data bar with original state, “A” =
different than original state, “N” = same as original state.
The digital information is displayed in tabular form. The data columns are described below:
Column Number
1 – Cursor State
2 – Title
3 – Fst
4 – Lst
5 – Fst-Change
6 – Lst-Change
7 – Changes

Description
The digital state of the sample at the cursor position (A=Alarm, N=Normal).
The channel title, a maximum of 40 characters can be displayed.
The digital state of the first sample (A=Alarm, N=Normal).
The digital state of the last sample (A=Alarm, N=Normal).
The time the channel first changed state.
The time the channel last changed state.
The number of times the channel-changed state.

Use the scroll bar or the up and down arrow keys to navigate through the digital channels and use the tab
key to toggle between the analog and digital views.

ANALOG CHANNEL SCALE
The analog table displays the channels scale in inches or centimeters with respect to the units of the
channel. The analog table column is Scale. The scale value is adjusted according to the current auto scale
mode, OFF, ON, ++ or Units and is adjusted when the channels amplitude is increased or decreased.
In auto scale mode OFF the scale is equal to the maximum value in the display. In auto scale mode ON
the scale is set to the channel’s maximum value allocated for display from the zero reference line. In auto
scale mode ++ the scale uses the channel’s maximum and minimum values allocated for display, ignoring
the zero reference line. In Units mode all channels are scaled according to the maximum and minimum
values for each group of channels with the same units.

CUSTOMIZING THE ANALYSIS DISPLAY
The “Properties” option in the “File” menu allows for customizing the analysis display window. Below is a
definition of each tab:


Analog Table – The Analog Table tab is used to reorder, hide and show the columns in the
Analog Table.



Analog Combination – The Analog Combination tab is used to change the position of the data
values in the Combination view.



Comtrade – The Comtrade tab is used to define the Comtrade format for saving, the date and
time format for display and for setting automatic conversion from RMS data to Peak data when
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using the “Save As Comtrade” feature. It also allow for converting UTC to local time to support the
new 2013 Comtrade format,


Colors – The Colors tab is used to define the background colors of each display section and to set
the default analog channel colors.



Values File – The Values File tab is used to define the Values File and general information used
when saving samples values to a file.



Display Settings – The Display Settings tab is used to define the Scale Multiplier for the traces
and phasor/circular chart scaling. It also can define general display information for the window
such as: setting the display trace type (sample based or time based), defining the Phase Angle
Convention (Sine or Cosine), showing the time reference bar between the analog channels and
the digital channels, showing the separator bar between multiple events displayed in one window,
showing or hiding the fault bar (red dotted vertical bar), and defining the option to reference angles
across windows when Sync mode is active. When “Yes” is defined for reference angles across
windows all phase angles for the currently opened windows will be referenced from the first
marked channel in the active window.



Append / Merge – The Append/Merge tab is used to define from which file the samples will be
discarded from when the discard common times option is used. It also is used to determine
whether the station name should be added to the analog/digital titles when an append/merge
option is executed.



Driver Data Type – The Driver Date type tab is used to define the type of data that is saved to the
displayed device’s data file: RMS Type or Peak Type, convert the analog sample values between
primary and secondary and for editing the ratio values.



Filters – The Filters tab is used to define if spikes detected in the data file should be ignored when
the maximum and minimum values are calculated and at what level they should be ignored.

TIME & SAMPLE BASED DISPLAYS
The “Trace Display Type” field located in the “Display Settings” tab of the “Properties” dialog allows for
toggling between the “Time Based” display and the “Sample Based” display. The sample based display
plots the channel data with one pixel distance between each displayed sample. Sample based displays are
useful for showing changes in sampling frequency. The time based display plots the channel data in time.
Time based displays are useful for showing changes in line frequency.
To change the trace display type open the “Properties” dialog under the “File” menu. Click the “Display
Settings” tab and change the “Trace Display Type” field to time based or sample based.

FAULT REFERENCE TIME BAR
The Fault Reference Time Bar is displayed between the analog and the digital traces. It displays the time
difference from the fault time defined in the displayed file. The units are displayed in the Delta X status
field.
To show or hide the fault reference time bar open the “Properties” dialog under the “File” menu. Click the
“Display Settings” tab and select “Yes” or “No” for the “Show Reference Time Bar” field.

SUPERIMPOSING ANALOG CHANNELS
To superimpose two or more analog channels, mark the channels and press F7 or select the “Super
Impose” menu option from the “Data” menu. Multiple groups of channels can be superimposed in one
display. To superimpose the current channels mark the channel then press F7. The channels will
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automatically be unmarked after a superimpose operation. Next, mark the voltage channels and press F7.
If no channels are marked and the channels are superimposed then all channels will be un-superimposed,
Press F7 to turn this feature ON/OFF.

CHANGING ANALOG CHANNEL COLORS
To change the color of an analog channel, click the opposite mouse button on the channel ID. Select the
channel color from the list or click “More Colors” to select from the color palette. Channels must be
unmarked to change their colors.

SYNCHRONIZING DATA CURSORS
The Sync Data Cursors feature is used to synchronize the data bars for two or more display windows. To
synchronize two or more data bars, open the files, select “Tile Horizontal” from the Windows menu, then
select the “Sync Data Cursors” menu option from the “Data” menu. This feature offers two sync functions:
“By Time” and “Manually”. When a function is selected, the data bars in the non-active windows are moved
to the synchronization point of the active window. The two functions are described below:
By Time
When the time function is activated, the data bars in the non-active windows are moved to the sample
time of the data bar in the active window. For example, if the data bar in the active window is positioned
on a sample at time 01:12:34.5600 all of the non-active data bars are moved to the sample at that time.
If the time cannot be found the data bar does not move.
Manually
The manual sync function allows for the selection of different cursor positions in the windows before
synchronization is activated. For example, open four display windows and tile horizontally. Move the
data bar to the beginning of the fault cycle in each window and select the Manual cursor sync function.
Press the left arrow, right arrow, ctrl+left, ctrl+right, page up, page down, ctrl+page up, ctrl+page down,
home and end keys or use the scrollbar to move the data bars.

Figure 3.18 Cursor Synchronization
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In Sync Mode phase angles can be referenced across analysis display windows. The phase angles in the
opened data windows are referenced by the first marked channel in the active data window. This feature is
activated from the “Properties” dialog under the "Display Setting" tab in the Sync Mode section. Sync
Mode must be active for the angles to be referenced.

APPEND OPEN FILES
The “Append Open Files” menu option under the “File” menu appends all of the open windows into a new
display window. There are two options available under the Append Open Files Menu:
 Discard Common Times: Any common times found in the open files will be deleted from the oldest
file.
 Back to Back: The files are appended back to back. No samples are deleted.

MERGE OPEN FILES
The “Merge Open Files” option under the “File” menu merges all of the displayed or marked channels into
one display window. There are three options available under the Merge Open Files Menu:


By Time: Merge channel samples if they have a common time segment. The reference time is
taken from the file with the latest start date and time. The file with the least number of samples
determines the length of the new merged file.



Manually: Use the data bars to highlight the location of the common sample time in each window.
Then Merge Manually will line up the data bars and adjust the time stamps accordingly. This
option is used when the file times are not synchronized. The active window determines the time
stamp of the new merged file and the open window with the least number of samples determines
the length of the new merged file.



By Sample: Merge without regard to time stamps and/or data bar positions. The reference time is
taken from the active window. The file with the least number of samples determines the length of
the file.

When files with different sampling frequencies are merged a dialog will be displayed. The dialog contains a
list of all the sampling frequencies in the opened files. Select the frequency for the merged file or enter a
new frequency.

Figure 3.19 Merge Open Files: Select Frequency
Merging Open Files allows for flexibility of which channels are merged. “Merge Open Files” will merge
either the marked channels only, if there are no marked channels then it will merge the visible channels.
If the merged files have different data types (RMS Calibrated or Peak Values) the RMS values will be
automatically converted to Peak values by multiplying the RMS values by Root 2.
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To identify the merged channels the station name for each file is added to the beginning of the analog and
digital channel titles. To turn off this feature open the “Properties” dialog
. Click on the
“Append/Merge” tab and uncheck the “Add the File’s Station Name to Beginning of the Analog/Digital
Channels” field.

Figure 3.20 Append/Merge Properties
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Figure 3.21 Merge Open Files – By Time: Open files and select channels to Merge

Figure 3.22 Merge Open Files – By Time: Result: By Time
Merge Open Files “By Time” will only merge the samples with common times. The reference time is the file
with the latest start date and time.
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Figure 3.23 Merge Open Files – Manually: Select Channels & Position Data Bars
First, select the channels to merge by marking the channels and pressing the <enter> key. Next, position
the data bars at the point representing the Same Point in time.

Figure 3.24 Merge Open Files – Result: Manually
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Merge Open Files Manually is used when the file times are not synchronized. Place the data bars in the
position where the times should be synced and merge the files. Merge will align the samples according to
the position of the data bar in each open file. The data bar with the least number of samples at the
beginning determines the number of samples to truncate from the beginning of all other open files. The
active window’s time stamp is used for the merged file and the open file with the least number of samples
determines the length of the merged file.

Figure 3.25 Merge Open Files – Result: By Sample (As Applied to Figure 1.70)
Merge Open Files “By Sample” merges without regard for time stamps and/or data bar positions. It merges
“as is”. The reference time is from the active window and the file with the least number of samples
determines the length of the file.

CHANGE FREQUENCY
Change Frequency changes the current sampling frequency to the entered frequency. If the entered
frequency is greater than the current frequency then samples are added. If the entered frequency is less
than the current frequency then samples are deleted. The following screen dumps show an example that
sets a multiple frequency file to a single frequency. The entered frequency must be greater than two times
the line frequency.
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Figure 3.26 Change Frequency Dialog
It also allows for defaulting a driver to always display its’ files using the entered frequency. For example, all
SEL 4 samples/cycle (240ƒs) files can be set to automatically display 40 samples/cycle (2400ƒs).
NOTE: If Open Frequency is checked the Restore Original is not available.

Figure 3.27 Change Frequency: Change a Mutiple Frequency File

98

Chapter 3 – Analysis Quick Start

Figure 3.28 Change Frequency: Results

TRUNCATE CYCLES
Truncate Cycles removes the specified number of cycles from the analysis display. Three options are
available under the “Truncate Cycles” submenu option.




Left: Remove all cycles from the first sample to the data bar.
Right: Remove all cycles from the data bar to the last sample.
Middle: Remove all cycles from the data bar to the reference bar (blue dotted line).
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Figure 3.29 Truncate Cycles: Append Non Time Matching Waveforms
After appending two waveform files it may be necessary to truncate the cycle that did not match. First,
align the reference bar on the peak before the appended position then align the data bar on the peak
following the appended position and select the truncate middle menu option.

Figure 3.30 Truncate Cycles: Results
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DUPLICATE CYCLES
Duplicate Cycles duplicates the cycle at the data bar by the number of times entered in the Duplicate
Cycles Dialog. This feature is useful for creating Comtrade files to play back to test set applications and for
modeling and simulation applications. Refer to the following screen sumps for an example that adds five
cycles of fault cycles to a file.

Figure 3.31 Duplicate Cycles Dialog

Figure 3.32 Duplicate Cycles: Initial File
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Figure 3.33 Duplicate Cycles: Add 5 Fault Cycles

RESTORE ORIGINAL DATA
Restore Original Data will reread and display the sample values from the active waveform file on disk. Any
changes made to the analysis window, such as: duplicate cycles, change frequency and truncate cycles
will be lost when this feature is activated. If the Open Frequency option is checked in the “Change
Frequency” dialog the Restore Original is not available.

MARK RAW VALUES
Mark Raw Values marks the raw values saved in the active waveform file on disk. A small hollow blue
circle is placed at the raw value. This feature is helpful in highlighting the raw sample values saved in low
sampling rate files.
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Figure 3.34 Mark Raw Values

MARK PEAK VALUES
Mark Peak Values marks the peak sample values for all visible analog traces. A small solid gray square is
placed at the peak values. This feature is helpful in highlighting the positive and negative peak values.

Figure 3.35 Mark Peak Values
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MARK CHANGE IN SIGN VALUES
Mark Change In Sign marks all samples where a change in sign occurs. A small solid gray triangle is
placed at the change position. This feature is helpful in highlighting the position where a change in sign
occurs in the signal.

Figure 3.36 Mark Change in Sign

CHANGE ANALOG VALUES (PRIMARY  SECONDARY)
The values displayed in the analog table are either in primary or secondary quantities. If the file defines the
type of values saved the type is displayed in the window header. Also, if the CT and PT ratios are defined
in the configuration file the values can be changed from primary to secondary and vice versa. To change
the values open the properties dialog and click on the “Driver Data Type” tab, and select the Primary or
Secondary radio button to switch between values.

Figure 3.37 Type of Analog Values Displayed
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Figure 3.38 Change Analog Values (Primary  Secondary)
The CT and PT ratio values can be edited by clicking on the “Edit Ratio Values” button in the “Driver Data
Type” tab. The values are listed in a table format for each analog channel. The modified ratio values are
not saved to the original file. To save the edited ratio values use the “Save As: Comtrade” option under the
“File” menu.

105

Chapter 3 – Analysis Quick Start

Figure 3.39 Ratio Values

ADJUST FILES TIME
The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust File Time” dialog,
select the "Adjust Files Time" menu option under the "Data" menu. You can specify to add or subtract a
given time increment from the files current time. Enter the desired time increment for the hour, minutes,
seconds and milliseconds. If there is no adjustment needed on a specific time field enter 0.
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Figure 3.40 Adjust Files Time
To always have the file's time automatically adjusted when a specific driver is used to open a file check the
"Adjust Open Time" check box.
To show the file’s original date and time click on the “Restore Original” button
Original Data” menu option under the “Data” menu.

or select the “Restore

CREATING VIRTUAL CHANNELS
The analysis window allows for ten software analog channels (SAC) and eight software digital channels
(SDC). These additional virtual channels exist only in RAM. The sample values are created using a
function of the existing analog/digital channels. Predefined operators can be used to calculate a missing
phase, create positive/negative and zero sequence channels; convert channels to secondary or primary
values; calculate V/I for fault resistance/impedance, multiply, divide, add and subtract multiple channels;
multiply, divide, add and subtract channel data by a constant value; create an envelope of an analog
channel; define over-trigger or under-trigger values; calculate a missing phase; define the prefix and unit
for the channel; or perform bit-wise ANDing/ORing on digital traces.
All calculations are designed to operate "on the fly". For the forward looking SAC operator ("@" some
positive angle) care must be taken. Upon opening a file and while the system is reading the data samples,
the forward samples are not available. In that case, the system uses the current sample instead of the
requested forward sample. To execute forward looking SAC instructions, wait until the file is read and
displayed, use F5 to recalculate.
SAC title and operators can be saved to an ASCII text file on disk by using the “Save” and “Save As”
buttons located to the right of the SAC operators. The “Open” button allows for opening existing SAC files
without having to manually enter the SAC titles and operators. These features are useful for reusing
existing SAC operations on like files. The “New” button clears the existing SAC title and operators.
The SAC and SDC instructions are composed of an operator and an operand. An operand can be a
channel defined by the channel number or a constant. Constant values must have a “^” operator before
each value to distinguish between channel numbers and constant values. To phase shift analog channels,
use the “@” sign before each angle defined. All angles must be defined in degrees. Following is a list of all
the software operators that are available:



“+”
“-“

- Add (Analog),
- Subtract (Analog),
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“*”
“:”
“^”
“@”
“e”
“a”
“<”
“>”
“h”
“h=”
"x"
"y"
"m"
"d"
"r"
"f"
"q"
"t"
“s”
“c”
"b"
“|”
“p=”
“u=”
“+”
“.”
“/”

- Multiply (Analog),
- Divide (Analog),
- Constant value (Analog),
- Phase Shift (Analog),
- Adjusted envelope (Analog),
- Envelope (Analog),
- Under-trigger (Analog),
- Over-trigger (Analog),
- Harmonic for Channel (Analog),
- Harmonic for all Back Operations (Analog),
- real component (Analog),
-imaginary component (Analog),
-magnitude (Analog),
-angle (Analog),
-true RMS (Analog),
-cyclic frequency (Analog),
-instantaneous frequency (Analog),
-delta time frequency (Analog),
- sin operator (Analog),
- cos operator (Analog)
-operate between bars only (Analog),
- Absolute Value (Analog),
- Prefix (Analog),
- Unit (Analog),
- And (Digital),
- Or (Digital),
- Instruction terminator (Analog & Digital)

NOTE: All SAC/SDC operations are performed in Reverse Polish Notation (one operation at a time).
The instruction set must always terminate with a “/”. An operation error is generated if the
instruction formats are not followed.
Operators are formatted as a stacked set of instructions. To select from the predefined fast SACs click on
the drop down list than double click on the desired SAC. The name of the SAC is in the first column and
the operator is in the second column. To have the SAC name automatically copied to the SAC title click on
the “Set SAC Titles using Fast SAC headers” check box. The position of the channel in the operators is
marked by a Pound Sign #. If there are any marked channels in the data plotting window then the fast SAC
will be populated with the marked channels number. For example if channels 4, 5 and 6 are marked and
the Calculate Neutral fast SAC is selected then the Operator will be displayed as: +4/+5/+6/u=A/. If there
are no channels marked the operator will be +#/+#/+#/u=. The user will have to replace the # with the
desired channels and complete the unit.
An instruction is composed of four attributes:
1. The operator: +, -, *, :, ...
2. The operand: channel index (1, 2, 3, ...) or constant value (such as ^3.14)
3. The function: @, h, x, y, m, d, f, ...
4. Instruction terminator: /
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Press F5 to display the SAC dialog or select “Software Analog Channels” from the Channels menu. To
display the SDC dialog select “Software Digital Channels” from the Channels menu. Below are some
examples:
Operations
Addition

Example
+7/+8/+9/

Subtraction

+7/-8/-9/

+ Sequence

+1/+2@120/+3@240/:^3/p=k/u=volt/

- Sequence

+1/+2@240/+3@120/:^3/p=k/u=volt/

0 Sequence

+1/+2/+3/:^3/p=k/u=volt/

Harmonics

+16/h=1/p=k/u=volt/

Multiplication

+3/*^2.66/

Division

+7/:3/

Half Cycle
Envelope
Envelope

+2/e/

Under-trigger

+4/<135/

Over-trigger

+62/>500/

Absolute Value

+7/+8/+9/|/p=k/u=Volts/

Frequency

+7f/u=Hz/

Frequency

+7q/u=Hz/

Magnitude

+11m/u=V/p=k/

Real

+4x/+5x/+6x/u=V/

Imaginary

+4/+5/+6/y2/u=V/

Secondary

+1/:^3000/u=V/

Impedance
(V/I)

+4/:6/h=1/u=mho/

+12/a/

Description
Add channels 7, 8, & 9 and store the result in
the SAC.
Subtract channel 8 from channel 7, and store
the result in the SAC then subtract channel 9
from the SAC and restore the values in the
SAC.
Calculate the + sequence components and
store the result in the SAC then set the SAC’s
prefix and unit.
Calculate the - sequence components and
store the result in the SAC then set the SAC’s
prefix and unit.
Calculate the zero sequence components and
store the result in the SAC then set the SAC’s
prefix and unit.
st
Extract the 1 Harmonic component from
Channel 16 and store in the SAC then set the
SAC’s prefix and unit.
Multiply all sample values in channel 3 with
the constant value 2.66 and store the result in
the SAC.
Divide all samples values in channel 7 by the
sample values in channel 3 and store the
result in the SAC.
Calculate the half cycle envelope of channel 2
and store the result in the SAC.
Calculate the envelope of channel 12 and
store the result in the SAC.
Store all the sample values from channel 4
that are < 135 in the SAC.
Store all the sample values from channel 62
that are > 500 in the SAC.
Add channels 7, 8, & 9 and store the absolute
value of the result in the SAC then set the
SAC’s prefix and unit.
Store the cyclic frequency of channel 7, and
set the SAC’s unit to Hertz.
Store the instantaneous frequency of channel
7, and set the SAC’s unit to Hertz.
Store the magnitude of channel 11, and set
the SAC’s unit to Volt and the prefix to k.
Store the real components of the fundamental
of 4, 5 and 6 and set the SAC’s unit to Volts.
Store the imaginary components of 2nd
harmonic of 4, 5 and 6 and set the SAC’s unit
to Volts.
Store channel 1 values divide by 3000 and set
the SAC’s unit to V.
Store the fundamental of channel 6 (V)
divided by channel 1 (I) and set the SAC’s unit
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Operations

Example

Differential
Current

+1/+2/+3/+4/|/u=A/

Apparent
Power (1=V,
4=I)
Power Factor

*1m/*4m/p=k/u=Watts/

Active Power

+1d/-4d/c/*1m/*4m/p=k/u=Watts/

Reactive Power

+1d/-4d/s/*1m/*4m/p=k/u=Vars/

AND

+2/.33/

OR

+2/.4/+14/

+1d/-4d/c/u=Deg/

Description
to mho.
Store the absolute value of the sum of
channels 1 2 3 and 4 and set the SAC’s unit
to A.
Store the magnitude of channel 1 multiplied
by the magnitude of channel 4 and set the
SAC’s prefix to k and the units to Watts.
Store the cosine of the angle of channel 1
minus the angle of channel 4 then set the
SAC’s unit to Deg.
Calculate the cosine of channel 1 angles
minus channel 4 angles, then store the
calculated value multiplied by channel 1
magnitudes and channel 4 magnitudes, set
the SAC’s prefix to k and the unit to Watts.
Calculate the sine of channel 1 angles minus
channel 4 angles, then store the calculated
value multiplied by channel 1 magnitudes and
channel 4 magnitudes, set the SAC’s prefix to
k and the unit to Watts.
AND channel 2 with channel 33 and store the
result in the SAC.
AND channel 2 with 4, then OR the result with
channel 14 and store the result in the SAC.

Figure 3.41 SAC Dialog
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Figure 3.42 SAC Results
Engineers can use the additional channels as a generic tool for monitoring or modeling tasks. A virtual
channel can be used to compute one of the phases of a monitored line by adding the remaining phases
then subtracting the result from the residual channel. This in turn frees up a hardware channel for other
monitoring needs.
The SAC operators and titles can be saved to an ASCII text file on disk to save time when re-entering SAC
operator and titles. The SAC files can have any filename but the extension must be .SAC. If an extension
is entered when saving a SAC file then the extension is deleted and .SAC is added to the filename. The
active SAC path and filename is displayed in the first status field. The second status field indicates if the
SAC title or operator fields where modified.
There are 4 options for the SAC files, Open, New, Save and Save As. Each option is explained below:
SAC File Operator
Open

New

Save
Save As

Description
Open an existing SAC file. The Window’s open file dialog is displayed.
Navigate to the desired folder and double click on the SAC file. The SAC
title and operator fields are populated with the contents of the selected file.
If the file is not a valid SAC file then an error message is displayed.
Clear the current SAC title and operators and change the SAC filename in
the first status field to Untitled. If the previous SAC title and operators where
modified then a message will be prompted asking to save the existing SACs
before clearing the fields.
Save the active SAC title and operators to the SAC file listed in the first
status field. If the SAC filename is listed as Untitled then the “Save As”
dialog is displayed.
Save the existing SAC title and operators to a new SAC file. The Window’s
“Save As” dialog is displayed. Navigate to the desired folder and enter the
new name in the “File name” field and click the “Save” button or press enter.
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Figure 3.43 Open SAC File

PLAY CHANNELS AUDIO
It is now possible to hear the characteristics of a signal through the analysis window. To play the audio of a
specific analog channel first mark the channel. Then open the “Analog Channel Audio” dialog by selecting
the “Play Channels Audio” menu option under the “Data” menu. The Analog Channel Audio dialog is
displayed in the bottom right hand corner of the analysis window.
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Figure 3.44 Play Audio Dialog
The “Active Channel” section displays the analog channel marked in the analysis window. The “Audio
Controls” section allows for playing the active analog channel’s data through the computers speakers and
for increasing/decreasing the volume of the output. The “Save .WAV File” section allows for saving the
analog channel data in the Window’s .WAV format. Click the folder button
to select a destination folder
and to enter a new “.WAV” file or for selecting an existing “.WAV” file. The selected folder and filename will
be updated in the “Audio Filename” field.
To view the saved “.WAV” file exit the analysis window, navigate to the “.WAV” folder and double click on
the wave file. A new display driver has been added to plot Microsoft’s “.WAV” files.

ALIGN CHANNEL DATA
The “Align Channel Data” option aligns the analog channel samples according to the defined phase shift
rd
angles. The alignment routines use the Thiran 3 Order All Pass Fractional filter. The all-pass delay
guarantees no magnitude deterioration and fractional because delays can be a fraction of the sample
interval.
To align the analog channels manually select the “Align Channel Data” menu option under the “Channel”
menu. If the Thiran filter has already been applied to the displayed analog channels a message is
displayed.

Figure 3.45 Align Channel Message
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To continue to the “Align Channel Data” dialog click “Yes”. To apply the filter to the file’s original unfiltered
data click “No” or “Cancel”. Then select the “Restore Original Data” menu option under the “Data” menu or
click on the “Restore Original” menu button.
The “Align Channel Data” dialog applies the Thiran filter according to the entered Phase Shift angles.
Enter the phase shift angle for each analog channel. If the filter does not apply to a specific analog channel
enter 0 or leave the field blank or enter NONE. To display the coefficient values used for each analog
channel click the “Calculate Coefficients” button. The “A0, A1, A2 and A3” fields will be updated with the
coefficients for the entered phase shift angles.

Figure 3.46 Align Channel Data Dialog
To always apply the Thiran filter on files for the active driver click the “Always Apply” check box. Always
apply automatically runs the Thiran filter with the defined phase shift angles before displaying the file. To
display the files original samples click the “Restore Original” menu button
Original Data” menu option under the “Data” menu.

or select the “Restore

The coefficients used for the filter can be edited. If the coefficients are modified click the “Use Entered
Coefficients Values” radio button. To have the coefficients automatically calculated when the filter is
applied click the “Calculate Coefficients at Run” radio button.
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USER VIEWS
User Views allow for saving and displaying specific information about a selected view. When a view is
saved the following information is saved to an ASCII text file in the user defined folder.














Displayed analog channels,
Analog channel order,
Superimposed channels,
Analog channel colors,
Digital channels displayed,
Sampling frequency,
Time scale,
Sliding window size (RMS bar to Data bar),
Phasor window size,
Table window size,
Red fault bar,
Auto scale and
Phasor or circular chart displayed

To save a view, first setup the desired view. Then select the “Save View” menu option under the “View”
menu. The “Save View” dialog is displayed.

Figure 3.47 Save View Dialog
Enter the view’s name in the “View Name” field and select or enter the destination folder into the “View File
Path” field. By selecting the destination folder, it is possible to save a hierarchy of views that allows for
easy access to specific views according to the users preference. The channels to save can be
manipulated in the Analog and Digital tables. To also save a print profile view, check the “Save a Print
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Profile” checkbox. Click the orientation type and header type. A short header will print the basic file
information listed in the Waveform Summary window. The Advanced header will print the basic file
information, analog and digital information from the Waveform Summary window.
To select a view open the view drop down menu. The drop down menu lists the last seven saved/selected
views. If the view is not listed click on the “More View” option to open Microsoft’s select file dialog.
Navigate to the view’s folder and double click on the view file.

Figure 3.48 Select View Drop Down Menu
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Figure 3.49 Select View File Dialog
To view the details of a saved view before selecting it, open the “Select View” dialog from the “View”
menu. The select view dialog has four sections. On the left side of the dialog is the list of all the available
views located in the displayed view path. To change the view path either use the browse button or select a
previous navigated directory from the “View Path” drop down list. Under the view files is the window’s
settings defined in the file. On the right side is the view information for each analog channel and digital
channel in the view.
A number of manufactures save the lines contained in a DFR record in the header format of the file. The
Transcan, Faxtrax, Director, USI and APP recorders save the line definitions in the header section of the
file. These predefined lines are listed in the top section of the view drop down menu. Refer to Figure 3.52.
For Transcan, Faxtrax and Director recorders the line definitions are defined in the proprietary header files.
For USI and APP the line definitions are stored in the Comtrade .HDR file. The HDR files are located in the
manufactures install path. To define the location of the USI and APP line definition files open the “Device
Configuration” dialog. Refer to the “Device Configuration” section in the File Manager Quick Start. Select
the USI Comtrade Files or the APP Comtrade Files under the “Drivers” list box. On the right hand side
enter the path for the line definition files in the “Driver’s Line Directory” field.
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Figure 3.50 Select View Details Dialog
Double click on the view file or select the file and click “OK”. If the analog channel and digital channel
names defined in the view file are not in the displayed file than an error message is displayed. To exit the
dialog without selecting a view, click on the “Cancel” button.

SINGLE ENDED FAULT LOCATION CALCULATOR
The single ended fault location calculator calculates a single ended Fault Location. The single ended
calculator has two types of calculators: the “Radial Line Method” and the “Reactance Method”.
To open the single ended fault location calculator, select the “Single Ended” submenu option from the
“Fault Calculators” menu option under the “Data” menu.”
The single ended calculator is a stay on top window which allows for changing the position of the data bar
while the dialog is open. To use the cursor keys to move the data bar make sure the data window is the
active window.
Radial Line Method:
To calculate the radial line method click on the “Radial Line Method” tab. Select the faulted voltage
channel from the “V Channel Number” drop down list and select the faulted current channel from the “I
Channel Number” drop down list. Next, enter the Z1 and Z0 magnitude and angle. If the Z1 and Z0 values
are stored in the opened file then these fields will be automatically populated.
The magnitude and angle for “Vf” and “If” are read from the data bar position in the selected open window.
To change the position of the data bar, click on the desired location in the waveform window. The data
values will be automatically populated and the fault location is updated. To update the fault location click
on the “Calculate” button.
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Figure 3.51 Single Ended Fault Calculator: Radial Line Method
Reactance Method:
To calculate the reactance method click on the “Reactance Method” tab. Select the Voltage fault channel
from the “V Channel Number” drop down list, select the faulted current channel from the “I Channel
Number” drop down list and select the neutral channel from the “N Channel Number” drop down list. Next,
enter the Z1 and Z0 magnitude and angle. If the Z1 and Z0 values are stored in the opened file header
then these fields will be automatically populated.
The magnitude and angle for “Vf”, “If” and “IN” are read from the data bar position in the selected open
window. To change the position of the data bar, click on the desired location in the waveform window. The
data values will be automatically populated and the fault location is updated. To update the fault location
click on the “Calculate” button.
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Figure 3.52 Single Ended Fault Calculator: Reactance Method
Multi-Phase Method:
To calculate the multi-phase method click on the “Multi-Phase” tab. Select the two faulted voltage channels
from the “Vf1 Channel Number” and “Vf2 Channel Number” drop down lists, select the two faulted current
channels from the “If1 Channel Number” and “If2 Channel Number” drop down lists. Next, enter the Z1 and
Z0 magnitude and angle. If the Z1 and Z0 values are stored in the opened file header then these fields will
be automatically populated.
The magnitude and angle for “Vf1”, “Vf2”, “If1” and “If2” are read from the data bar position in the selected
open window. To change the position of the data bar, click on the desired location in the waveform
window. The data values will be automatically populated and the fault location is updated. To update the
fault location click on the “Calculate” button.
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Figure 3.53 Single Ended Fault Calculator: Multi-Phase Method
Three-Phase Method:
To calculate the tree-phase method click on the “Three-Phase” tab. Select the three faulted voltage
channels from the “VA”, “VB” and “VC” drop down lists, select the three faulted current channels from the
“IA”, “IB” and “IC” drop down lists. Next, enter the Z1 and Z0 magnitude and angle. If the Z1 and Z0 values
are stored in the opened file header then these fields will be automatically populated.
The magnitude and angle for “VA”, “VB”, “VC” “IA”, “IB” and “IC” are read from the data bar position in the
selected open window. To change the position of the data bar, click on the desired location in the
waveform window. The data values will be automatically populated and the fault location is updated. To
update the fault location click on the “Calculate” button.
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Figure 3.54 Single Ended Fault Calculator: Three-Phase Method
Plot the Single Ended Fault Location:
To plot the fault location in the data plotting window as a new channel, click on the drop down arrow in the
plot button. The two options are plot the fault location between bars or plot the fault location for the entire
record. The default option of the plot button is plot between bars. Between bars plots the fault location
between the data bar and the reference bar.

Figure 3.55 Single Ended Plot Button
Before plotting the fault location between bars make sure the data and reference bar are positioned on the
proper samples in the data plotting window.
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Figure 3.56 Single Ended Plot Radial: Channel 18

DOUBLE ENDED FAULT LOCATION CALCULATOR
The double ended fault location calculator calculates a double ended Fault Location using the two open
fault records (near and far ends). The near end is the top left window displayed. To reorganize the
windows use the Tile buttons

.

The double ended fault location dialog is first displayed in the summary mode. The summary mode has the
basic input fields (ZL and line length) along with the fault location results. To expand the window to show
the details of the fault location click on the “Show Details” button.

Figure 3.57 Double Ended Fault Calculator: Summary Window
If the fault location is based on the summary window then the channels in each record must be organized
as follows: the first 3 visible channels are the voltage channels, VA, VB and VC. The next 3 visible
channels are the current channels, IA, IB and IC. To reposition the analog channels first mark the channels
then use the plus key to move the channels up one position and the minus key to move the channels down
one position. If the channels are not organized as listed then click the “Show Details” button then change
the channel numbers using the drop down list to the left of the channel labels.
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The values populated in the dialog are read at the data bar positions from both open records. The double
ended dialog is a stay on top window. This allows for repositioning the data bars without closing the dialog.
To refresh the Voltage and Current values in the dialog use the Refresh button.
To increment the voltage and current angles for the near end and far end enter an increment value in the
angle rotation fields and click on the “Rotate” button. This allows for a more accurate fault location when
the results angle is closest to zero.
Use the “Calculate” button to calculate the double ended fault location. To open the double ended dialog
select the "Fault Calculators" sub menu option under the "Data" menu then select the "Double Ended"
menu option.

Figure 3.58 Double Ended Fault Calculator: Details

124

Chapter 3 – Analysis Quick Start

Plot the Double Ended Fault Location:
To plot the fault location in the data plotting window as a new channel, click on the drop down arrow in the
plot button. The two options are plot the fault location between bars or plot the fault location for the entire
record. The default option of the plot button is plot between bars. Between bars plots the fault location
between the data bar and the reference bar.

Figure 3.59 Double Ended Plot Button
Before plotting the fault location between bars make sure the data and reference bar are positioned on the
proper samples in the data plotting window.

Figure 3.60 Double Ended Plot: Channel 19
The action for each button in the double ended fault location dialog is listed below:
Button
ZL Settings

Image

Description
The ZL settings button displays the ZL settings for the two
open records. A red ! symbol is displayed next to the button
if the ZL settings do not match.

Refresh

Refresh the data values from both open records.

Calculate

Calculate the double ended for the data values at the
cursor position.

Plot

Plot the double ended fault location for the top displayed
record. Plot between bars or for the entire record.
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Close

Close the double ended fault location window.

Show/Hide Details

Show/Hide the details section of the double ended fault
location window.

Rotate

Rotate the Angles to get as close to zeros as possible.

Auto Scale

Turn Auto Scale On/Off for the Phasors diagram.

Up Arrow

Increase the Phasors by a multiplier of 2.

Down Arrow

Decrease the Phasors by dividing by 2.

SEQUENCE COMPONENTS CALCULATOR
The sequence components calculator calculates the zero, positive and negative sequence components for
the data values at the data bar for the active window (single) or for two open windows (end to end).
The channels in the active records must be organized as follows: The first 3 visible channels are the
voltage channels, VA, VB and VC. The next 3 visible channels are the current channels, IA, IB and IC. To
reposition the analog channels first mark the channels then use the plus key to move the channels up one
position and the minus key to move the channels down one position. If the channels are not organized as
suggested then the channel numbers can be changed directly in the dialog using the drop down list to the
left of the channel labels.
The values populated in the dialog are read at the data bar positions in the open records. The sequence
calculator dialog is a stay on top window. This allows for repositioning the data bars without closing the
dialog. To refresh the voltage and current values in the dialog use the “Refresh” button.
Use the “Calculate” button to calculate the sequence components. To increment the voltage and current
angles enter an increment value in the “Angle Rotation” field and click on the “Rotate” button. To open the
sequence calculator dialog select the "Sequence Calculator" menu option under the "Data" menu.

Figure 3.61 Sequence Components Calculator Dialog – Single End
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Figure 3.62 Sequence Components Calculator Dialog – End to End

SAVE AS: CSV FORMAT
The save as CSV format allows for saving specific analog information into a CSV comma delimited format.
There are two sub-menus under the "Save As" option: "Comtrade" and "CSV Format". The "Comtrade"
option saves the displayed channels in either the ASCII or Binary format. The "CSV Format" will save the
RMS, Instantaneous or Vector (Magnitude and Angle or RMS and Angle) values to a comma delimited text
file.
The first line in the CSV file is the header information for each channel. All the analog channels displayed
in the active data plotting window are saved.
A dialog box is displayed to enter the destination path and the filename. The destination path is
automatically defaulted to the active path in the file manager. The filename can be directly entered into the
"File Name" field or the file can be automatically named using the IEEE C37.232 long file naming format.
To have the file automatically named click on the "ComNames" check box. If the "ComNames" check box
is checked then the File Name field will be disabled. To enter a file name make sure the "ComNames"
check box is unchecked.
The four Save As CSV options are:
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Save As CSV - RMS Values: Save the RMS Values in a comma delimited format.
Save As CSV - Instantaneous Values: Save the Instantaneous Values in a comma delimited format.
Save As CSV - Vector Values (Mag & Ang): Save the DFT Magnitude and Angle in a comma
delimited format.
Save As CSV - Vector Values (RMS & Ang): Save the RMS Value and Angle in a comma delimited
format.

Figure 3.63 Save As: CSV Format Menu

Figure 3.64 Save As: CSV Format Dialog
The “Save As” CSV dialog fields are described below:


Path: The path field is automatically defaulted to the active path in the Wavewin file manager. To
change the “Path”, enter a new path in the edit box or click on the browse button
to select an
existing path.



File Name: Enter the file name in the edit box. The file name edit box is only active for input if the “Use
the ComNames Standard to Name the file” check box is unchecked. To save the file using the IEEE
C37.232 long file naming format click on the “Use the ComNames Standard to Name the file” check box.



Use the ComNames Standard to Name the File: The “Use the ComNames Standard to Name the file”
check box will automatically assign the file name using the IEEE C37.232 long file naming format. If the
check box is checked then the file name field is disabled.
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The file format saved is a comma delimited text file and the .CSV extension is automatically assigned. The
first line in the file defines the header information. The first two columns are the samples date and time.
Below is an example of the header:
DATE(0/DATE),TIME(1/TIME),IA(4/Amps),IB(4/Amps),IC(4/Amps),VA(4/Volts),VB(4/Volts),VC(4/Volts)
All files saved using the Save As CSV format are recognized as plotting files using the SDC display driver.
Wavewin will automatically recognize the saved format and display it in the data plotting window.
Below are screen dumps of some of the “Save As CSV” option.

Figure 3.65 Save As: CSV Format - RMS Display
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Figure 3.66 Save As: CSV Format - Vector Display

HARMONIC ANALYSIS REPORT
The harmonic analysis report runs the harmonic calculation on each channel from harmonics 0 (dc-offset)
to the maximum harmonic (samples per cycle/2). To run the harmonic analysis report, select the
“Harmonic Analysis Report” menu option under the “Data” menu. When selected the Harmonic Analysis
dialog is displayed. Enter the harmonics above the percentage of fundamental to report on, the number of
amps below to ignore during the analysis and the number of voltage below to ignore, Press the “Run
Report” button to start the analysis.
The final report is an ASCII text file. The top section list the summary information for the file. The analysis
report is in a table format and lists the following columns:








Harmonic number,
Date and Time the harmonic was first detected,
Sample number the harmonic first detected,
Magnitude at the Sample number (DFTPeak),
Fundamental,
Percentage of the fundamental,
Duration how long the harmonics was detected.
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Figure 3.67 Harmonic Analysis Dialog

Figure 3.68 Harmonic Analysis Report

TVE CALCULATOR
The TVE (Total Vector Error) calculator is used to calculate the TVE for synchro phasor measurements.
TVE is defined as the square root of the difference squared between the real and imaginary parts of the
theoretical actual phasor and the estimated phasor. The equation used in the calculator is from the IEEE
C37.118-2005 Standard, Equation # 2.
The TVE is calculated on the first displayed channel or the first marked channel. To mark channels use the
spacebar or mouse. Marked channels are displayed in red.
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To open the TVE calculator select the “TVE Calculator” menu option under the “Data” menu. Once
selected the TVE dialog is displayed.
The TVE dialog is a stay on top dialog allowing for the data bar to be moved in the data window while the
dialog is open. To use the cursor keys to move the data bar make sure the data window is the active
window. To populate the Measured values with the values at the data bar click the “Refresh” button. Enter
the Actual values then click the “Calculate” button to show the TVE between the Actual values and the
measured values. Click the “Close” button to close the dialog.

Figure 3.69 TVE Calculator

FREQUENCY CALCULATOR
The frequency calculator is used to measure the frequency between the reference bar and the data bar.
To open the frequency calculator select the “Frequency Calculator” menu option from the “Data” menu.
Once selected the Frequency dialog is displayed in the upper right corner of the data plotting window.
The frequency dialog is a stay on top dialog allowing for the data bar to be moved in the data window
while the dialog is open. When using the cursor keys to move the data bar make sure the data window is
the active window. To Delta X values will be automatically updated when the data bar is moved in the
data plotting window. Enter the number of cycles between the reference bar and data bar then click the
“Calculate” button to show the frequency value. The number of cycles is displayed in the status bar in the
Delta X section. Click the “Close” button to close the dialog.
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Figure 3.70 Frequency Calculator

133

Appendix A – System Keys

A

P

P

E

N

D

I

X

A

System Keys
This section lists the function keys, cursor keys, and menu buttons available in the file manager, query fields
and analysis window.

File Manager
Function Keys
F1
F2
F3
F4
F5
F7
F8
F9
F11
F12

Description
Display the file table’s help file.
Display the file, at the cursor position in text format: ASCII Editor.
Display the file, at the cursor position in hexadecimal format: Hex Editor.
Display a list of the DAU-DEF station titles found in the active directory.
Display the command line dialog to run an application.
Change the active path to the specified destination path.
Copy the marked files to the destination path.
Move the marked files to the destination path.
Display a sequence of events table for all the marked waveform files.
Refresh the folder tree and the current directory

Cursor Keys
Left Arrow
Right Arrow
Up Arrow
Down Arrow
Page Up
Page Down
Home
End
Ctrl+Home
Ctrl+End
Tab
Delete
Enter
Backspace
Character keys

Description
Move the cursor bar to the left one position.
Move the cursor bar to the right one position.
Move the cursor bar up one position.
Move the cursor bar down one position.
Display the files on the previous page.
Display the files on the next page.
Move the cursor to the first column in the file table.
Move the cursor to the last column in the file table.
Move the cursor to the first file in the file table.
Move the cursor to the last file in the file table.
Move the cursor from the file table to the query fields.
Delete all the marked files and empty directories.
Run the driver at the cursor position.
Change the active path to the previous directory.
Move to the next row in the active column that starts with the entered character.

Menu Buttons

Description
Show / Hide the Folder Tree

Folder Tree
Email
Refresh
ChDir
Previous Dir

Email all marked files and their support files.
Refresh the current directory from disk.
Change the active path to the specified destination path.
Change to the previous directory.
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Last Dir
Copy
Move
Mark
Query

Change to the last navigated directory.
Copy the marked files to the destination path.
Move the marked files to the destination path.
Mark/Unmark all visible files.
Query all files in the active directory.

Plot

Plot the data contents for the highlighted file.

Summary

Display the waveform summary for the file at the cursor position.

Edit

Edit the contents of the file at the cursor position: ASCII Editor

Load Analysis

Perform load analysis on the marked files.

Query Fields
Function Keys
F1
F5
F6
F7
F8
F9

Description
Display the query help file.
Query all the marked devices in the active configuration.
Query all the devices in the active configuration.
Query all the unmarked devices in the active configuration.
Clear the query criteria and set all the query operators to “=”.
Toggle through the available query operators for the active query field.

Cursor Keys
Up Arrow
Right Arrow
Left Arrow
Tab
Shift+Tab
Enter

Description
Return the cursor to the device table.
Move the cursor one position to the right, wraps to next field at the end.
Move the cursor one position to the left, wraps to next field at the beginning.
Move the editor to the next query field.
Move the editor to the previous query field.
Process the query criteria for all devices in the active configuration.

Menu Button

Description
Query all devices in the active configuration.

Query

Analysis
Function Keys
F1
F2
F3
F4
F5
F6
F7
F8

Description
Display the data help file.
Display the analog and digital channel information.
Generate a max/min peak chart and an EN/SR summary log.
Toggle between the available analog views.
Display the software analog channel dialog.
Turn channel amplitude auto scaling ON or OFF.
Turn super imposing ON/OFF for all or marked channels.
Mark or unmark all the visible analog/digital channels.
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F9
F11

Toggle between the available digital views (All or Triggered).
Display the harmonics table.

Cursor Keys
Left Arrow
Right Arrow
Ctrl+Right Arrow

Description
Move the data bar to the left one sample.
Move the data bar to the right on sample.
Move the data bar to the next peak for the first display channel or the first
marked channel.
Move the data bar to the previous peak for the first display channel or the first
marked channel.
Move the data bar ahead one cycle for the first displayed channel or the first
marked channel.
Move the data bar back one cycle for the first displayed channel or the first
marked channel.
Shift the analog information table to the left by one column.
Shift the analog information table to the right by one column.
Page up through the data.
Page down through the data.
Move the data bar to the first data sample.
Move the data bar to the last data sample.
Increase the amplitude for all or marked channels.
Decrease the amplitude for all or marked channels.
Expand the time scale for all visible channels.
Condense the time scale for all visible channels.
Toggle between the analog and digital channels.
Move the cursor up one channel.
Move the cursor down one channel.
Display the analog/digital channels on the previous page.
Display the analog/digital channels on the next page.
Display the first page of the analog/digital channels.
Display the last page of the analog/digital channels.
Mark or Unmark the channel at the cursor position.
Mark or Unmark a group of channels while moving the cursor up.
Mark or Unmark a group of channels while moving the cursor down.
Display the hidden channels that were removed by the delete keys.
Hide the marked channels and respace the unmarked channels.
Hide the unmarked channels and respace the marked channels.
Display all the hidden channels or exit the data window.
Display all the hidden channels.
Shift all the marked channels up one position.
Shift all the marked channels down one position.
Move the reference bar to the sample at the cursor bar.
Move the RMS bar to the sample at the reference bar.

Ctrl+Left Arrow
Shift+Ctrl+Right
Arrow
Shift+Ctrl+Left Arrow
Shift+Left Arrow
Shift+Right Arrow
Page Up
Page Down
Home
End
Ctrl+Up Arrow
Ctrl+Down Arrow
Ctrl+Page Up
Ctrl+Page Down
Tab
Up Arrow
Down Arrow
Shift+Page Up
Shift+Page Down
Ctrl+Home
Ctrl+End
Spacebar
Shift+Up Arrow
Shift+Down Arrow
Insert
Delete
Enter
Esc
Backspace
+
Ctrl-A
Ctrl-Z
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Menu Buttons
Reopen File

Description
Reopen a previous viewed waveform file.

Email Active File

Email the active file and any support files needed.

View Raw Data

View the waveform`s raw data file in an ASCII or binary editor.

Summary

View the Analog/Digital Summary of the active displayed file.

Recorder Chans
Inc
Dec

Display the waveform's analog/digital channel headers and scale factors.

ASV

Magnify the amplitude of the marked channels.
Attenuate the amplitude of the marked channels.
Turn auto scaling ON/OFF for all visible channels.
Condense the time scale of the visible channels.

In
Out
View Marked
View All

Expand the time scale of the visible channels.

Set Ref Bar

Hide the unmarked channels and respace the marked channels.
Replot all the hidden channels.
Move the reference bar to the sample at the cursor bar.

SetRMS Bar

Move the RMS bar to the sample at the reference bar.

Properties
Restore Original
Change Freq.
Duplicate Cyc.
Resize Sliding
Window
Select Views

Display the Window Properties dialog.
Restores the samples to the original raw samples stored in the file.
Change the frequency of the active display file.
Duplicate the cycle and number of times at the data bar.
Resize the RMS sliding window.
Select a specific line or view from the drop down list.
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align channel data .................................................... 113
amplitude
descrease .............................................................. 85
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analog channel scale .................................................. 90
analog combination .................................................... 90
analog commands ...................................................... 82
analog table ................................................................ 90
analog view .......................................................... 70, 87
append log files .......................................................... 47
append open files ....................................................... 93
append/merge ............................................................ 91
ascii editor .................................................................. 37
auto convert to comtrade ............................................ 58
auto process templates .............................................. 65
auto scale ................................................................... 84
auto scale multiplier .................................................... 85
auto set data bar ........................................................ 79
C
cad-dxf
display constants
background color ............................................... 49
filename ............................................................. 49
max x pixels ....................................................... 49
max y pixels ....................................................... 49
viewer..................................................................... 48
zooming ............................................................. 48
calibration report......................................................... 46
change frequency ....................................................... 97
change path................................................................ 17
channels
colors ..................................................................... 92
decrease amplitude ................................................ 85
decrease time scale ............................................... 85
delete ..................................................................... 84
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increase time scale ................................................ 85
mark ....................................................................... 84
reposition ............................................................... 86
restore .................................................................... 84
scale....................................................................... 84
super impose ......................................................... 91
sync data cursors ................................................... 92
virtual channels .................................................... 107
zoom ...................................................................... 85
circular chart ............................................................... 74
colors .......................................................................... 91
combination view ........................................................ 89
combine log files......................................................... 48
command line parameters .......................................... 16

comname properties .................................................. 15
comname(s) rename ............................................ 14, 24
complex calculator ..................................................... 57
compress comtrade files ............................................ 23
comtrade .................................................................... 91
copy files .............................................................. 19, 20
cumulative values....................................................... 34
cursor bars
data........................................................................ 78
fault ........................................................................ 78
horizontal ............................................................... 78
reference ............................................................... 78
rms......................................................................... 78
cursor keys-Appendix A
data display.............................................................. 3
cursor keys-Appendix C
file table ................................................................... 1
query fields .............................................................. 2
customizing
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analog table ........................................................... 90
append/merge........................................................ 91
colors ..................................................................... 91
comtrade ................................................................ 91
data display............................................................ 90
display settings ...................................................... 91
driver data type ...................................................... 91
file manager ........................................................... 22
filters ...................................................................... 91
values file ............................................................... 91
cut files ....................................................................... 20
cycle hop .............................................................. 77, 78
D
data bar ...................................................................... 78
data display .......................................................... 25, 70
adjust file time ...................................................... 106
align channel data................................................ 113
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analog view ...................................................... 70, 87
append open files .................................................. 93
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double ended fault calculator ............................... 123
driver data type ...................................................... 75
duplicate cycles .................................................... 101
email active file ...................................................... 77
fault reference time bar .......................................... 91
formats ................................................................... 25
frequency calculator ............................................. 132
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histogram ............................................................... 72
mark and save ....................................................... 80
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mark raw samples ................................................ 102
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by sample .......................................................... 93
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